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Sensitivity

¢ “Model System Noise Figure” on page 1-2
® “Designing a Receiver with an ADC” on page 1-9



1 Sensitivity

Model System Noise Figure

RF receivers amplify signals and shift them to lower frequencies. The receiver
itself introduces noise that degrades the received signal. The signal-to-noise
ratio (SNR) at the receiver output ultimately determines the usability of the
receiver.

Output signal power T
l&'ﬂ-’ﬂn,,,
Qutput noise power T B

Input signal power T
SNR,,

Input noise power T i

L

fir fier

The preceding figure illustrates the effect of the receiver on the signal. The
receiver amplifies a low-power RF signal at the carrier f,, with a high SNR
and downconverts the signal to f;; The noise figure (NF) of the system
determines the difference between the SNR at the output and the SNR at
the input:

SNR,,; = SNR,,, — NF,

sys

where the difference is calculated in decibels. Excessive noise figure in
the system causes the noise to overwhelm the signal, making the signal
unrecoverable.

Create a Low-IF Receiver Model

The model ex_simrf_snr simulates a simplified IF receiver architecture. A
Sinusoid block and a Noise block model a two-tone input centered at f, and
low-level thermal noise. The RF system amplifies the signal and mixes it
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with the local oscillator f;, down to an intermediate frequency f;» A voltage
sensor recovers the signal at the IF.

To open this model, at MATLAB® command line, enter:

addpath(fullfile(docroot, 'toolbox"', 'simrf', 'examples'))
ex_simrf_snr

Configur ation Lo &nd

The amplifier contributes 40 dB of gain and a 15-dB noise figure, and the
mixer contributes 0 dB of gain and a 20-dB noise figure, which are values
characteristic of a relatively noisy, high-gain receiver. The two-tone input has
a specified level of .1 pV. A 1-V level in the local oscillator ensures consistency
with the formulation of the conversion gain of the mixer.

To run the model:

1 Open the model by clicking the link or by typing the model name at the
Command Window prompt.

2 Select Simulation > Run.

Set Up the SimRF Environment

To maximize performance, the Fundamental tones and Harmonic order
parameters specify the simulation frequencies explicitly in the Configuration
block:

1-3
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® f.o> the frequency of the LO in the first mixing stage, equals 1.9999 GHz.
and appears in the list of fundamental tones as carriers.LO.

® frp the carrier of the desired signal, equals 2 GHz and appears in the list of
fundamental tones as carriers.RF.

* fm the intermediate frequency, equals f,, — ;. The frequency is a linear
combination of the first-order (fundamental) harmonics of f;, and f5.
Setting Harmonic order to 1 is sufficient to ensure this frequency appears
in the simulation frequencies. This minimal value for the harmonic order
ensures a minimum of simulation frequencies.

Solver conditions and noise settings are also specified for the Configuration
block:

* The Solver type is set to auto. For more information on choosing
solvers, see the reference page for the Configuration block or see Choosing
Simulink® and Simscape™ Solvers.

* The Sample time parameter is set to 1/ (mod_freq*64). This setting
ensures a simulation bandwidth 64 times greater than the envelope signals
in the system.

® The Simulate noise box is checked, so the environment includes noise
parameters during simulation.

View Simulation Output

The model uses subsystems with a MATLAB Coder™ implementation of a
fast Fourier transform (FFT) to generate two plots. The FFT uses 64 bins,
so for a sampling frequency of 64 Hz, the bandwidth of each bin is 1 Hz.
Subsequently, the power levels shown in the figures also represent the power
spectral density (PSD) of the signals in dBm/Hz.

¢ The Input Display plot shows the power spectrum of the signal and noise
at the input of the receiver.
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ex_simrf_snr/Input Display/fft_2 E@
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The measured power of each tone is consistent with the expected power

level of a 0.1-uV two-tone envelope:

V2
Pin =1010g10 ﬁ +30

2
1107
2 2

= 1010g10 2.50 +30=-142 dBm

A factor of 1/2 is due to voltage division across source and load resistors, and
another factor of 1/2 is due to envelope scaling. See the featured example
Two-Tone Envelope Analysis Using Real Signals for more discussion on

scaling envelope signals for power calculation.

The measured noise floor at -177 dBm/Hz is reduced by 3 dB from the
specified -174 dBm/Hz noise floor. The difference is due to power transfer
from the source to the input of the amplifier. The amplifier also models a
thermal noise floor, so although this decrease is unrealistic, it does not

affect accuracy at the output stage.

1-5
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e The Output Display plot shows the power spectrum of the signal and noise
at the output of the receiver.

ex_simrf_snr/Output Display/fft_2 E@
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The measured PSD of -102 dBm/Hz for each tone is consistent with the
40-dB combined gain of the amplifier and mixer. The noise PSD in the
figure is shown to be approximately 50 dB higher at the output, due to the
gain and noise figure of the system.

If you have DSP System Toolbox™ software installed, you can replace the
MATLAB Coder subsystems with Vector Scope or Spectrum Analyzer blocks.

Simulating Thermal Noise Floor

Thermal noise power can be modeled according to the equation
Proise =4k TR Af

where:

® kyis Boltzmann’s constant, equal to 1.38065 x 1023 J/K.

e Tis the noise temperature, specified as 293.15 K in this example.

® R_is the noise source impedance, specified as 50 Q in this example to agree
with the resistance value of the Resistor block labeled R1.
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® Afis the noise bandwidth.

To model the noise floor on the RF signal at the resistor, the model includes a
Noise block:

* The Noise Power Spectral Density (Watts/Hz) parameter is calculated
! Af =4kgTR, .

¢ The Carrier frequencies parameter, set to carriers.RF, places noise on
the RF carrier only.

as B, noise

Computing System Noise Figure

To model RF noise from component noise figures:

1 Select Simulate noise in the SimRF Parameters block dialog box, if it is
not already selected.

2 Specify a value for the Noise figure (dB) parameter of an Amplifier and
Mixer blocks.

The noise figures are not strictly additive. The amplifier contributes more
noise to the system than the mixer because it appears first in the cascade.
To calculate the total noise figure of the RF system with n stages, use the
Friis equation:

Fyys =F1+F2_1+F3_1+...+ £ -1
G, GG, G,Gs..G,_;

where F, and G, are the noise factor and gain of the ith stage, and
NF; = 10log, ,(F)).

In this example, the noise figure of the amplifier is 10 dB, and the noise figure
of the mixer is 15 dB, so the noise figure of the system is:

1015/10 _¢

] =10.0dB

The Friis equation shows that although the mixer has a higher noise figure,
the amplifier contributes more noise to the system.
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For more information on RF system noise figure, see the featured example
Impact of RF Receiver on Communcations System Performance.
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Designing a Receiver with an ADC

Most RF receivers in modern communications or radar systems feed signals
to an analog-to-digital converter (ADC). Due to their finite resolution, ADCs
introduce quantization error into the system. The resolution of the ADC is
determined by the number of bits and the full-scale (FS) range of the ADC.

FU“'SE&“'IE‘ p(}w?r :II- ..........................................

Output signal powerT DR gy
SNR,.
Qutput nolse power e
Ouaﬂ[izauﬂﬁ "U's? ﬂﬂ(]l‘" -----------------------------------------
Input signal power T

SNR,,

Imput noise powerT vt

fir fng

The preceding figure illustrates an RF signal that falls within the dynamic
range (DR) of an ADC. The input signal and noise at the carrier f,, has high
signal-to-noise ratio (SNR). The received signal at f,; has reduced SNR due
to system noise figure. However, if the quantization error is near or above
the receiver noise, system performance degrades.

To ensure that the ADC contributes no more than 0.1 dB of noise to the signal
at f the quantization noise floor must be 16 dB lower than the receiver
noise. This condition can be met by:

¢ Reducing the full-scale (FS) range or increasing the resolution of the ADC,
which lowers the quantization noise floor.

¢ Increasing the gain of the RF receiver, which raises the receiver noise floor.

Overcome Quantization Error of an ADC

The model ex_simrf_adc simulates a low-IF receiver with an ADC. This
model is based on the model ex_simrf_snr described in the section “Create
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a Low-IF Receiver Model” on page 1-2. At the output of the RF system, the
ADC subsystem models an ADC with an FS range of sqrt(100e-3) V and a
resolution of 16 bits.

To open this model, at MATLAB command line, enter:

addpath(fullfile(docroot, 'toolbox"', 'simrf', 'examples'))
ex_simrf_adc

Output Sensor

' In I>Dul In
®Dul +—oRF  SL|—#{in1 Outl
Lo
Amplfier FDC DuputDiplay
Mxer
RF SL—D R

Caonfigur ation o Gnd =

The power of a voltage signal at the full-scale range of the ADC is
10log19vV100~3 +30 = 0 dBm

To maximize performance, the model uses the same simulation settings as
ex_simrf_snr. To run this model:

1 Open the model by clicking the link or by typing the model name at the
Command Window prompt.

2 Select Simulation > Run.

View Simulation Output

The model uses subsystems with a MATLAB Coder implementation of a
fast Fourier transform (FFT) to generate two plots. The FFT uses 64 bins,
so for a sampling frequency of 64 Hz, the bandwidth of each bin is 1 Hz.
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Subsequently, the power levels shown in the figures also represent the power
spectral density (PSD) of the signals in dBm/Hz.

® The Input Display plot shows the power spectrum of the two-tone signal
and noise at the input of the receiver-ADC system.

ex_simrf_adc/Input Display/fft_2 E@
File Edit View Inset Tools Desktop Window Help kl
DEde KRR O0PEA- S/ 0EH|aD
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The measured power of each tone of -142 dBm is consistent with the
expected power level of a .1-1V signal. The power level of the noise is
consistent with a -174 dBm/Hz noise floor.

® The Output Display plot shows power spectrum of the output signal.

1-11
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ex_simrf_adc/Output Display/fft_2 E@
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The quantization error exceeds the receiver noise.

If you have DSP System Toolbox software installed, you can replace the
MATLAB Coder subsystems with Vector Scope or Spectrum Analyzer blocks.

Measuring the Quantization Noise Floor
To calculate the quantization noise floor (QNF) of the ADC, subtract the
dynamic range from the full-scale power, which is 0 dBm. To calculate the
dynamic range PSD for the ADC, use the equation:

DRjpc =6.02- Ny, +101ogq (Af)+1.76 =116.1 dBm/Hz

where

® N, 1is the resolution. The ADC in this example uses 16 bits.

® Afis the bandwidth of the FFT, which is 64 in this example. Oversampling
in an ADC yields lower quantization noise.

® The value 1.76 is a correction factor for a pure sinusoidal input.

Therefore, the quantization noise floor is -116 dBm/Hz, in agreement with
the measured output levels.
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Improving Receiver-ADC Performance

Increasing the gain in the mixer raises the receiver noise without increasing
the noise figure. Calculate the mixer gain required to achieve a 16-dB margin
between the quantization noise floor and the receiver noise:

Grnixer = (@NFypc +16) - (=174 + G + NFy )
=(-116.1+16) - (-174 +40+10.0)
=-100.1+124.0
=23.9dB

To simulate a receiver that clears the quantization noise floor:

1 Set the Available power gain parameter of the mixer to 23.9.

2 Select Simulation > Run.

ex_simrf_adc/Output Display/fft_2 E@
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The figure shows that the receiver noise is 16 dB above the quantization
noise floor.
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Interference

e “Carrier to Interference Performance of a Weaver Receiver” on page 2-2

® “Model LO Phase Noise” on page 2-9



2 Interference

Carrier to Interference Performance of a Weaver Receiver

A classic superheterodyne architecture filters images prior to frequency
conversion. In contrast, image-reject receivers remove the images at the
output without filtering but are sensitive to phase offsets.

A~
¥=
¥ =
¥

Fi frr fr Fiu l
The preceding figure illustrates two input signals at the carriers f;, and
fny that both differ from the LO frequency, f;;, by an amount f,;. Mixing
translates both input signals down to f;,. Perfect image rejection in the final
stage of the receiver removes the image signal from the output entirely.

Create a Model with RF Interference

The model ex_simrf_ir simulates image rejection in a Weaver architecture.
The receiver downconverts the signals at f,, and f;,, to f;p, and f in two
sequential stages.

To open this model, at MATLAB command line, enter:

addpath(fullfile(docroot, 'toolbox', 'simrf', 'examples'))
ex_simrf_ir
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To run the model:

1 Open the model by clicking the link or by typing the model name at the
Command Window prompt.

2 Select Simulation > Run.

Set Up the SimRF Environment

To maximize performance, the Fundamental tones and Harmonic order
parameters specify the minimal set of simulation frequencies explicitly in the
Configuration block:

® from the RF carrier, equals 100 MHz.

fro1> the frequency of the LO in the first mixing stage, equals 150 MHz

fnp the image of the RF carrier relative to f;,, equals 200 MHz.

fip> the intermediate frequency of the signal after the first mixing stage,
equals f; o, — frr = fir — fr.or = 50 MHz.

® f,00> the frequency of the LO in the second mixing stage, equals 75 MHz.

® fim, the intermediate frequency of the signal after the second mixing stage,
equals f; o, — f13y = 26 MHz. In this system, every carrier is a multiple of f;z,.

2-3
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The largest carrier, f;;,, is the 8th harmonic of f;;,, so setting Fundamental
tones to f; and Harmonic order to 8 ensures that every carrier is in
the set of simulation frequencies.

Solver conditions and noise settings are also specified for the Configuration
block:

* The Solver type is set to auto. For more information on choosing solvers,
see the reference page for the Configuration block or see Choosing Simulink
and Simscape Solvers.

* The Sample time parameter is set to 1/ (mod_freq*64). This setting
ensures a simulation bandwidth 64 times greater than the envelope signals
in the system.

® The Simulate noise box is checked, so the environment includes noise
parameters during simulation.

View Simulation Output

The model uses subsystems with a MATLAB Coder implementation of a fast
Fourier transform (FFT) to generate four plots.

¢ The RF Display plot shows the power spectrum of the signal recovered
from the carrier f,, specified as carriers.RF in the Carrier frequencies
parameter of the preceding SimRF Outport block.
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ex_simrf_ir/RF Display/fft_2 E@
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The modulation of the RF carrier is a constant envelope generated by
a Continuous Wave block which generates a single peak centered at the
carrier.

The Image Display plot shows the power spectrum of the image. The signal
is recovered from the carrier f;,,, specified as carriers.IMin the Carrier
frequencies parameter of the preceding SimRF Outport block.

2-5
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ex_simrf_ir/Image Display/fft_2 E@
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The Sinusoid source generates a two-tone signal centered at f;;,.

¢ The IF1 Display plot shows a power spectrum centered at the first
intermediate frequency, measured between the first and second stages.
The sensor outputs the modulation from the carrier f;;;, specified as
carriers.IF2 in the Carrier frequencies parameter of the preceding
SimRF Outport block.

2-6



Carrier to Interference Performance of a Weaver Receiver

ex_simrf_ir/IFL Display/fft_2
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Both the RF and image appear on the carrier. The power level of the image

40 dB higher than the RF.

The Output Display plot shows the effects of the RF system. The sensor
outputs the modulation from the carrier f;,, specified as carriers.IF1
in the Carrier frequencies parameter of the preceding SimRF Outport

block.

ex_simi_ir/Output Display/fft_2
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As expected, the system removes the image and amplifies the RF by 6 dB.

If you have DSP System Toolbox software installed, you can replace the
MATLAB Coder subsystems with Vector Scope or Spectrum Analyzer blocks.

Modeling RF and Blocker Sources

To model more robust input signals, you can use a SimRF Inport block

to specify a circuit envelope generated using blocks from other Simulink
libraries. For example, the featured example “Impact of an RF Receiver

on Communication System Performance” uses Communications System
Toolbox™ blocks to model a QPSK-modulated waveform of random bits with
SimRF Inport that brings the signal into the SImRF™ environment.

Simulating LO Phase Offset

The phase shifters have specified Phase shift parameters of 90. Deviation
from this value results in a phase offset and causes imperfect image rejection.
The featured example “Measuring Image Rejection Ratio in Receivers”
analyzes the IRR of the Weaver and Hartley architectures several times,
calculating the image rejection ratio (IRR) for several different phase offsets.
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Model LO Phase Noise

A mixer transfers local oscillator (LO) phase noise directly to its output.

ff:"ljmlf.l'n"l
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The preceding figure shows the transfer of phase noise from f; ,, to fz.

Create a Model with Phase Noise

The model ex_simrf_phase_noise introduces phase noise into the model
from the section “Create a Model with RF Interference” on page 2-2. The first
mixing stage downconverts the RF and image to f;

To open this model, at MATLAB command line, enter:

addpath(fullfile(docroot, 'toolbox', 'simrf', 'examples'))
ex_simrf_phase_noise
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View Simulation Output

The model uses subsystems with a MATLAB Coder implementation of a fast
Fourier transform (FFT) to generate four plots.

¢ The IF1 Display plot shows a power spectrum centered at the first
intermediate frequency, measured between the first and second stages.

ex_simif_phase_noise/IFL Display/fft 2 (][ ]
File Edit View Insert Tools Desktop Window Help u
Ddde | |ARODEL- S 0H 8D

IF1 Display
T

Power (dBm)

-200
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Frequency (Hz) x10°
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The figure shows that the LO phase noise has been transferred to the
image. The RF signal on the carrier f;; is not visible in the figure because
its power level is below the phase noise power of the downconverted image
signal. The two visible peaks are at the same power as the IF shown in the
previous section, “Create a Model with RF Interference” on page 2-2.

® The Output Display plot shows the downconverted RF with the images
removed.

ex_simrf_phase_noise/Output Display/fft_2 E@
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The LO phase noise has been transferred to the receiver output. The peak
signal power is the same as in the previous section, “Create a Model with
RF Interference” on page 2-2.

If you have DSP System Toolbox software installed, you can replace the
MATLAB Coder subsystems with Vector Scope or Spectrum Analyzer blocks.

Shaping the LO Noise Skirt

To simulate phase noise, the model phase modulates pink noise generated in
the LO with Phase Noise subsystem.

2-11
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The subsystem contains the following blocks:
¢ A Random Number block outputs a Gaussian random number at discrete
time steps to generate white noise.

¢ A Gain block scales the signal by a factor of

P_/10
27 f1,01107
where f; , is the LO frequency and P, is the relative noise power density
in dBc/Hz.

® A Discrete Filter block filters the uniform white noise to generate 1/f noise.

® A Magnitude-Angle to Complex block phase modulates an input signal ¢.
The output is of the form exp(j@).

¢ An Inport block models a controlled voltage source in the SimRF
environment, modulating the carrier f;, with the input signal exp(j¢). The
circuit envelope equivalent signal is exp[j(2mf;,t + @(D)].

If you have Communications System Toolbox software installed, use the
Phase Noise block to add phase noise to a given input signal.
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Model a Direct Conversion Receiver

In this section...

“Create a Direct Conversion Receiver Model” on page 3-2

“Modeling IMD in System-Level Components” on page 3-7

“Examining DC Impairments” on page 3-8

Direct-conversion receivers are sensitive to second-order intermodulation
products because they transfer the RF signal directly to baseband.

Create a Direct Conversion Receiver Model

The model ex_simrf_dc models a direct-conversion receiver within the
SimRF environment. The RF system consists of a low-noise amplification
(LNA) stage, a direct-conversion stage, and a final amplification stage.

To open this model, at MATLAB command line, enter:

addpath(fullfile(docroot, 'toolbox"', 'simrf', 'examples'))
ex_simrf_dc
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To run the model:

1 Open the model by clicking the link or by typing the model name at the
Command Window prompt.

2 Select Simulation > Run.

Set Up the SimRF Environment
The model runs according to the following environment settings:

¢ In the Configuration dialog box, the Fundamental tones parameter
specifies the carriers in the SimRF environment:

= frr=f1o the carrier of the RF and the local oscillator.

= fg;, the blocker carrier
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The SimRF environment always simulates the 0 Hz carrier, regardless of
whether the SiImRF Parameters block specifies it.

In the Solver Configuration dialog box, the Use local solver box is
selected. This setting causes the SimRF environment to simulate with a
local solver with the following settings:

= Solver type is Trapezoidal rule.

= Sample time is sample_time, defined as 1.25e-4 in the model
Initialization function.

Since the model uses a local solver, the global solver settings do not affect

the simulation within the SimRF environment. For more information on

global and local solvers, see Choosing Simulink and Simscape Solvers.

To maximize performance, the Fundamental tones and Harmonic order

parameters specify the simulation frequencies explicitly in the Configuration
block:

® frr = 1o the carrier of the RF and the local oscillator, appears as a

fundamental tone.

® fgzr, the blocker carrier, appears as a fundamental tone.

e A carrier of 0 Hz, representing the passband signal, is included in the set

of first-order harmonics of both fundamental tones. Therefore, setting
Harmonic order to 1 is sufficient to ensure this frequency appears in the
simulation frequencies. This minimal value for the harmonic order ensures
a minimum of simulation frequencies.

Solver conditions and noise settings are also specified for the Configuration
block:

3-4

The Solver type is set to auto. For more information on choosing solvers,
see the reference page for the Configuration block or see Choosing Simulink
and Simscape Solvers.

The Sample time parameter is set to sample time, which is equal to
1/(mod_freq*64). This setting ensures a simulation bandwidth 64 times
greater than the envelope signals in the system.

The Simulate noise box is checked, so the environment includes noise
parameters during simulation.
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View Simulation Output
The model uses subsystems with a MATLAB Coder implementation of a fast
Fourier transform (FFT) to generate four plots:

¢ The RF Display plot shows the power level of the RF signal.

ex_simif_dc/RF Display/fft_2 [E=nE=R ===
File Edit View Insert Tools Desktop Window Help k]
ODdde | k| RR0TDEL- S 08 =d

RF Display
T
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-160

-180

-200
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Frequency (Hz) x10°

The power level of the RF is about 100 dBm.

¢ The Blocker Display plot shows the power spectrum centered at the carrier

far--
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ex_simrf_dc/Blocker Display/fft 2 E@
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The power level of the blocker is about 90 dB higher than the signal power
of the RF..

¢ The In-Phase Output plot shows the power spectrum of the in-phase signal
at baseband.

ex_simif_de/In-Phase Output/ft 2 [E=R[E=E =5

File Edit View Insert Tools Desktop Window Help
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In the figure, DC power is a direct result of the blocker and the IP2 in
the mixers.

® The Quadrature Output plot shows the power spectrum of the quadrature
signal at baseband.

ex_simrf_dc/Quadrature Output/fft_2 E@
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If you have DSP System Toolbox software installed, you can replace the
MATLAB Coder subsystems with Vector Scope or Spectrum Analyzer blocks.

Modeling IMD in System-Level Components

The IP2 and IP3 parameters specify the second- and third-order intercept
points of Amplifier and Mixer blocks:

® The amplifiers have infinite IP2 and IP3, so the amplifiers are linear.

® IP2 of the mixer is 15 dB
Amplifier and Mixer components have specified gains and noise figures:

® The gain and noise figure in the LNA stage are 25 dB and 6 dB, respectively.

¢ The gain and noise figure in the mixing stage are 10 dB and 10 dB.
The Input impedance (ohms) parameters of the two mixers are both
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100, which sum in parallel to a resistance of 50 Q to match the output
impedance of the LNA.

¢ The gain and noise figure in the final amplification stage are 20 dB and
15 dB, respectively.
To calculate RF system noise figure, use the Friis equation:
F,-1 F,-1 F -1
2428 44 n
Gy GGy G1Gsy...G, 4

where F; and G, are the noise factor and gain of the ith stage. For more
information on RF system noise figure, see the featured example “Impact of
an RF Receiver on Communication System Performance”.

F, .=F+

sys

Examining DC Impairments

In addition to intermodulation distortion from IP2, direct-conversion receivers
are subject to additional DC impairments. For example, coupling between
mixer input and local oscillator (LO) ports causes self-mixing of the LO. For
more information, see the featured example “Executable Specification of a
Direct Conversion Receiver”
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® “Model RF Components” on page 4-2

o “Specify or Import Component Data” on page 4-7
® “Specify Operating Conditions” on page 4-22

e “Model Nonlinearity” on page 4-24

e “Model Noise” on page 4-27
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In this section...
“Add RF Blocks to a Model” on page 4-2
“Connect Model Blocks” on page 4-3

Add RF Blocks to a Model

You can include blocks from the SimRF Equivalent Baseband Physical and
Mathematical libraries in a Simulink model. For more information on the
libraries and the available RF blocks, see “SimRF Equivalent Baseband
Libraries”.

This section contains the following topics:

¢ “Input Signal Requirements” on page 4-2

e “How to Add RF Blocks to a Model” on page 4-3

Input Signal Requirements

Most SimRF Equivalent Baseband blocks only support complex single-channel
signals. The signals can be either sample-based or frame-based. The following
blocks have this requirement:

e All Physical blocks
® Mathematical Amplifier and Mixer blocks

You can model the effect of these components on a multichannel signal as
follows:

1 Use a Simulink Demux block to split the multichannel signal into
single-channel signals.

2 Create duplicate RF models, with one model for each channel, and pass
each single-channel signal into a separate model.

3 Use a Simulink Mux block multiplex the signals at the output of the RF
models.
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How to Add RF Blocks to a Model
To add RF blocks to a Simulink model:

1 Type rflib at the MATLAB prompt to open the SimRF Equivalent
Baseband library.

2 Navigate to the desired library or sublibrary.

3 Drag instances of SimRF Equivalent Baseband blocks into the model
window using the mouse.

Note You can also access SimRF Equivalent Baseband blocks and other
Simulink blocks from the Simulink Library Browser window. Open this
window by typing simulink at the MATLAB prompt. Add blocks to the
model by dragging them from this window and dropping them into the model
window.

Connect Model Blocks

You follow the same procedure for connecting SimRF Equivalent Baseband
blocks as for connecting Simulink blocks: you click a port and drag the mouse
to draw a line to another port on a different block.

You can only connect blocks that use the same type of signal. Physical library
blocks use different types of signals than Mathematical library blocks, and
are represented graphically by a different port style. Therefore, you can freely
connect pairs of Mathematical modeling blocks. You can also freely connect
pairs of Physical modeling blocks. However, you cannot directly connect
Physical blocks to Mathematical blocks. Instead, you must use the Input Port
and Output Port blocks to bridge them.

For more information on the Physical and Mathematical libraries, including
how to open the libraries and a description of the available blocks, see
“Overview of SImRF Equivalent Baseband Libraries”.

This section contains the following topics:

® “Connect Mathematical Blocks” on page 4-4
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® “Connect Physical Blocks” on page 4-4
* “Bridge Physical and Mathematical Blocks” on page 4-5

Connect Mathematical Blocks

The Mathematical library blocks use the same input and output ports as
standard Simulink blocks. These ports show the direction of the signal at the
port, as shown in the following diagram.

RF Blockset mathematical
L. ——  modeling ports show signal
direction

hlizer

Similar to standard Simulink blocks, you draw lines between the ports of the
Mathematical modeling blocks, called signal lines, to represent signals that
are inputs to and outputs from the mathematical functions represented by
the blocks. Therefore, you can connect Simulink, DSP System Toolbox, and
SimRF Equivalent Baseband mathematical blocks by drawing signal lines
between their ports.

You can connect a port to multiple ports by branching the signal line, or you
can leave a port unconnected.

Connect Physical Blocks

The Physical library blocks have specialized connector ports. These ports only
represent physical connections; they do not imply signal direction.

RF Blockset physical modeling
& s ————— connector ports represent only
physical connections.

Microstrip

The lines you draw between the physical modeling blocks, called connection
lines, represent physical connections among the block components.
Connection lines appear as solid black when connected and as dashed red
lines when either end is unconnected.
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You can draw connection lines only between the connector ports of physical
modeling blocks. You cannot branch these connection lines. You cannot leave
connector ports unconnected.

Bridge Physical and Mathematical Blocks

The blockset provides the Input Port and Output Port blocks to connect
the physical and mathematical parts of the model. These blocks convert
mathematical signals to and from the physical modeling environment.

The Input Port and Output Port blocks have one of each kind of connector
port: a standard Simulink style input port and a physical modeling port.
These ports are shown in the following figure:

Mathematical, or Simulink style, ports

Input Physical Modeling Ports &| Dutput L
Port Poit

The Input Port and Output Port blocks must bound a physical subsystem to
connect it to the mathematical part of a model.

For example, a simple RF model of a coaxial transmission line might resemble
the following figure.

Input

. . Cutput -.I
E .E Port Mic ostrip Part 'I » M
White MNoiss Mic mstrip il

Input Portl Cutput Port

¥

Transmission Line

Center Frequency: 6500MHz

The Microstrip Transmission Line block uses an Input Port block to get its
white noise input from a Random Source block, and an Output Port block to
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pass its output to a Spectrum Scope block. The Random Source and Spectrum
Scope blocks are from DSP System Toolbox library.

For information on how SimRF Equivalent Baseband software converts
mathematical signals to and from the physical modeling environment, see
“Convert to and from Simulink Signals” on page A-33.
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Specify or Import Component Data

In this section...

“Specify Parameter Values” on page 4-7

“Supported File Types for Importing Data” on page 4-7

“Import Data Files into RF Blocks” on page 4-8

“Example — Import a Touchstone Data File into an RF Model” on page 4-10
“Import Circuits from the MATLAB Workspace” on page 4-14

“Example — Import a Bandstop Filter into an RF Model” on page 4-14

Specify Parameter Values
There are two ways to set block parameter values:

¢ Using the GUI — Enter information in the block dialog boxes, which open
when you double-click a block in the Simulink window.

¢ Using commands — Use the Simulink set_param and get_param
commands to set and get parameter values of the blocks, respectively. For
more information on these commands, see the set_param and get_param
reference pages.

Supported File Types for Importing Data

The blockset also lets you import the following types of data files:

¢ Industry-standard file formats — Touchstone S2P, Y2P, Z2P, and H2P
formats specify the network parameters and noise information for
measured and simulated data.

For more information on Touchstone files, see
http://www.vhdl.org/pub/ibis/connector/touchstone_spec11.pdf.

e Agilent® P2D file format — Specifies amplifier and mixer large-signal,
power-dependent network parameters, noise data, and intermodulation
tables for several operating conditions, such as temperature and bias
values.


http://www.vhdl.org/pub/ibis/connector/touchstone_spec11.pdf
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The P2D file format lets you import system-level verification models of
amplifiers and mixers.

e Agilent S2D file format — Specifies amplifier and mixer network
parameters with gain compression, power-dependent S,, parameters, noise
data, and intermodulation tables for several operating conditions.

The S2D file format lets you import system-level verification models of
amplifiers and mixers.

® MathWorks™ amplifier (AMP) file format — Specifies amplifier network
parameters, power data, noise data, and third-order intercept point

For more information about .amp files, see “AMP File Format” in the RF
Toolbox™ documentation.

e MATLAB circuits — RF Toolbox circuit objects in the MATLAB workspace
specify network parameters, noise data, and third-order intercept point
information of circuits with different topologies.

For more information about RF circuit objects, see “RF Circuit Objects”
in the RF Toolbox documentation.

Import Data Files into RF Blocks

The blockset lets you import industry-standard data files, Agilent P2D and
S2D files, and MathWorks AMP files into specific blocks to simulate the
behavior of measured components in the Simulink modeling environment.

This section contains the following topics:
e “Blocks Used to Import Data” on page 4-8

e “How to Import Data Files” on page 4-9

Blocks Used to Import Data

Three blocks in the Physical library accept data from a file. The following
table lists the blocks and any corresponding data format that each supports.
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Block Description Supported Format(s)

General Amplifier Generic amplifier Touchstone, AMP, P2D,
S2D

General Mixer Generic mixer Touchstone, AMP, P2D,
S2D

General Passive Generic passive Touchstone

Network component

How to Import Data Files
To import a data file:

1 Choose the block that best represents your component from the list of blocks
that accept file data shown in “Blocks Used to Import Data” on page 4-8.

2 Open the Physical library, and navigate to the sublibrary that contains
the block.

3 Click and drag the block into your Simulink model.

4 In the block dialog box, enter the name of your data file for the Data file
parameter. The file name must include the extension. If the file is not in
your MATLAB path, specify the full path to the file or use the Browse
button to find the file.

Note The Data file parameter is only enabled when the Data source
parameter is set to Data file. This is the default setting and it means the
block data comes from a file.
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E! Block Parameters: General Amplifier x|

—General Amplifier

Nonlinear amplifier described by a data souce that consists of either an RFDATA object ar
data from a file. Data interpolation iz used during simulation

When there is no noise data in the data source, use the Moise D ata tab to specify amplifier
noize infarmation

‘When there is no nonlinearity data in the data souce, use the Monlinsarity Data tab ta
specify amplifier nonlinearity information.

“when the data source containg operating condition information, wse the Operating
Conditions tab to select operating condition settings for the simulation.

INoiseData I Monlinearity Data | Visualization I Operating Conditions |

Data source: I Diata file: ;I
Data file: Idefault amp Browse Specify the file name
or use the Browse
RFDATA object: Iread[rfdata data, ‘default amp'] button to find the file
Interpolation method:l Linear ;I

ok I Cancel | Help | Apply |

The following section shows an example of this procedure.

Example — Import a Touchstone Data File into an
RF Model

In this example, you model the frequency response of a passive component
using data from a Touchstone file, defaultbandpass.s2p.

You use a model from one of the SimRF Equivalent Baseband examples to
perform the following tasks:
* “Import Data into a General Passive Network Block” on page 4-10

e “Validate the Passive Component” on page 4-13

Import Data into a General Passive Network Block

In this part of the example, you inspect the defaultbandpass.s2p file and
import data into the RF model using the General Passive Network block.
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1 Type the following at the MATLAB prompt to open the
defaultbandpass.s2p file:

edit defaultbandpass.s2p

The following figure shows a portion of the .s2p file.

=
File Edit Text Go Tools Debug Desktop Window Help o | A X
NS H|sRR9 ¢ |om - Aded -] >0
Option Line —
—# GHz 3 BRI B 50 g
! 3-Paramsters data
! Freq re3ll im311 re3zZl im3Z1 re3lz im31z2
0.1000000000 -0.9958171875
0.1004£20421 -0.9958154589
0.10082g2121 -0.9959813713¢&
0.1013225408 -0.959598118515
0.1018&£10170 -0.95958101724
0.102331&578 -0.99980837¢&1
0.1028044732 —-0.99980&5824
0.1032794732 —-0.99598047312 -
L | .. _'l_|
[ plain text Fie Ln 15 Col 206 [OVR

The option line

# GHz S RI R 50

specifies the following information about the contents of the data file:

¢ GHz — Frequency units.

e S — Network parameters are S-parameters.

¢ RI — Network parameters are specified as the real and imaginary parts.
® R 50 — Reference impedance is 50 ohms.

For more information about the Touchstone

specification, including the option line, see
http://www.vhdl.org/pub/ibis/connector/touchstone_speci1.pdf.
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2 At the MATLAB prompt, type

sparam_filter

This command opens the SImRF Equivalent Baseband example called
“Touchstone Data File for 2-Port Bandpass Filter,” as shown in the
following figure.
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Copyright 2002-2009 The MathWorks, Inc.
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3 Double-click the General Passive Network block to display its parameters.

The Data source parameter is set to Data file, so the Data file
parameter specifies the data file to import. The Data file parameter is set
to defaultbandpass.s2p. The block uses this data with the other block
parameters during simulation.

Note When the imported file contains data that is measured at frequencies

other than the modeling frequencies, use the Interpolation method
parameter to specify how the block determines the data values at the
modeling frequencies. For more information, see “Determine Modeling
Frequencies” on page A-3 and “Map Network Parameters to Modeling
Frequencies” on page A-5.
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Validate the Passive Component

In this part of the example, you plot the network parameters of the General
Passive Network block to validate the data you imported in “Import Data into
a General Passive Network Block” on page 4-10.

1 Open the General Passive Network block dialog box, and select the
Visualization tab.

2 Set the Source of frequency data parameter to User-specified.
3 Set the Frequency data (Hz) parameter to [0.5€9:0.1e6:1.5€e9].

4 Click Plot.

These actions create a plot of the magnitude and phase of S,; as a function
of frequency.
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S,, versus Frequency for the Imported Data
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Import Circuits from the MATLAB Workspace

You can only connect Physical library blocks in cascade. However, the
blockset works with RF Toolbox software to let you include additional circuit
topologies in an RF model. To model circuit topologies that contain other
types of connections, you must define a circuit in the MATLAB workspace and
import it into an RF model.

To import a circuit from the MATLAB workspace:

1 Define the circuit object in the MATLAB workspace using the RF Toolbox
functions.

For more information about RF circuit objects, see the RF Toolbox
documentation for “RF Circuit Objects”.

2 Add a General Circuit Element block to your RF model from the Black Box
Elements sublibrary of the Physical library. For information on how to
open this library, see “Open SimRF Equivalent Baseband Libraries”.

3 Enter the circuit object name in the RFCKT object parameter in the
General Circuit Element block dialog box.

This procedure is illustrated by example in the following section.

Example — Import a Bandstop Filter into an RF Model

In this example, you simulate the frequency response of a filter that you
model using circuit objects from the MATLAB workspace.

The filter in this example is the 50-ohm bandstop filter shown in the following
figure.
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Bandstop Filter Diagram
You represent the filter using four circuit objects that correspond to the
four parts of the filter, ckt1, ckt2, ckt3, and ckt4 in the diagram. You use

an input signal with random, complex input values that have a Gaussian
distribution to stimulate the filter. The scope block displays the output signal.

This example illustrates how to perform the following tasks:

® “Create Circuit Objects in the MATLAB Workspace” on page 4-15
¢ “Build the Model” on page 4-16

e “Specify and Import Component Data” on page 4-18

¢ “Run the Simulation and Plot the Results” on page 4-20

Create Circuit Objects in the MATLAB Workspace

In this part of the example, you define MATLAB variables to represent the
physical properties of the filter shown in the previous figure, Bandstop Filter
Diagram on page 4-15, and use functions from RF Toolbox software to create
RF circuit objects that model the filter components.

1 Type the following at the MATLAB prompt to define the filter’s capacitance
and inductance values in the MATLAB workspace:
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C1 = 1.734e-12;
C2 = 4.394e-12;
C3 = 7.079e-12;
C4 = 7.532e-12;
C5 = 1.734e-12;
C6 = 4.394e-12;

L1 = 25.70e-9;
L2 = 3.760e-9;
L3 = 17.97e-9;
L4 = 3.775e-9;
L5 = 17.63e-9;
L6 = 25.70e-9;

2 Type the following at the MATLAB prompt to create RF circuit objects
that model the components labeled ckt1, ckt2, ckt3, and ckt4 in the
circuit diagram:

ckt1 = ...
rfckt.series('Ckts',{rfckt.shuntrlc('C',C1),...
rfckt.shuntrlc('L',L1,'C',C2)});

ckt2 = ...
rfckt.parallel('Ckts',{rfckt.seriesrlc('L',L2),...
rfckt.seriesrlc('L',L3,'C',C3)});

ckt3 = ...
rfckt.parallel('Ckts',{rfckt.seriesrlc('L',L4),...
rfckt.seriesrlc('L',L5,'C',C4)});

ckt4 = ...
rfckt.series('Ckts',{rfckt.shuntrlc('C',C5),...
rfckt.shuntrlc('L',L6,'C',C6)});

For more information about the RF Toolbox objects used in this
example, see the rfckt.series, rfckt.parallel, rfckt.shuntrlc, and
rfckt.seriesrlc object reference pages in the RF Toolbox documentation.

Build the Model

In this portion of the example, you create a Simulink model. For more
information about adding and connecting components, see “Model RF
Components” on page 4-2.
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1 Create a new model.

2 Add to the model the blocks shown in the following table. The Library
column of the table specifies the hierarchical path to each block.

Block Library Quantity

Random Source DSP System Toolbox > Sources 1

Input Port SimRF > Equivalent Baseband > | 1
Input/Output Ports

General Circuit SimRF > Equivalent 4

Element Baseband > Black Box Elements

Output Port SimRF > Equivalent Baseband > | 1
Input/Output Ports

Spectrum Scope DSP System Toolbox > Sinks 1

3 Connect the blocks as shown in the following figure.

Change the names of your General Circuit Element blocks to match those
in the figure by double-clicking the text below the block and typing a new

name.
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Specify and Import Component Data
In this portion of the example, you specify block parameters. To open the

parameter dialog box for each block, double-click the block.
1 In the Random Source block dialog box:

® Set the Source type parameter to Gaussian.

® Set the Sample time parameter to 1/100e6.

® Set the Samples per frame parameter to 256.

¢ Set the Complexity parameter to Complex.

Selecting these settings creates an input signal with random, complex
input values that have a Gaussian distribution.

2 In the Input Port block dialog box:

¢ Set the Treat input Simulink signal as parameter to Incident power
wave.

® Set the Finite impulse response filter length parameter to 256.
e Set the Center frequency (Hz) parameter to 400e6.

® Set the Sample time parameter to 1/100e6.

¢ (Clear the Add noise check box.
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Selecting these settings defines the physical characteristics and modeling
bandwidth of the filter.

3 Set the parameters of the General Circuit Element blocks as follows:

¢ In the General Circuit Element1 block dialog box, set the RFCKT
object parameter to cktl.

¢ In the General Circuit Element2 block dialog box, set the RFCKT
object parameter to ckt2.

¢ In the General Circuit Element3 block dialog box, set the RFCKT
object parameter to ckt3.

¢ In the General Circuit Element4 block dialog box, set the RFCKT
object parameter to ckt4.

Selecting these settings imports the circuit objects that model the filter
components into the model.

4 In the Output Port block dialog box, set the Load impedance parameter
to 50.

5 Set the Spectrum Scope block parameters as follows:

¢ In the Scope Properties tab, set the Number of spectral averages
parameter to 100.

This parameter establishes the number of spectra that the scope
averages to produce the displayed signal. You use a value of 100 because
the input signal is random and you want to display the average filter
response over a large number of input values.

¢ In the Scope Properties tab, set the Spectrum units parameter to
dBm/Hertz.

¢ In the Axis Properties tab, set the Minimum Y-limit parameter to
-75 and the Maximum Y-limit parameter to -45.

These values set the range of x- and y-values on the display such that
the entire signal is visible when you run the simulation.

¢ In the Axis Properties tab, set the Y-axis label parameter to
dBm/Hertz.
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Run the Simulation and Plot the Results
In this part of the example, you run the simulation and examine the frequency
response of the filter.

Select Simulation > Start in the model window to start the simulation.

The Spectrum Scope window appears automatically and displays the following
plot, which shows the frequency response of the filter.
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Frequency Response of Bandstop Filter

The Spectrum Scope block displays the frequency response at the shifted
(baseband-equivalent) frequencies, not at the selected passband frequencies.
You can relabel the x-axis of the Spectrum Scope window to display the
passband signal by entering the Center frequency parameter value of
400e6 (from the Input Port block) for the Frequency display offset (Hz)
parameter in the Axis Properties tab of the Spectrum Scope block. For



Specify or Import Component Data

more information on complex-baseband modeling, see “Create a Complex
Baseband-Equivalent Model” on page A-13.

References

Geffe, P.R., “Novel designs for elliptic bandstop filters,” RF Design, February
1999.
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Agilent P2D and S2D files contain simulation results at one or more operating
conditions. Operating conditions define the independent parameter settings
that are used when creating the file data. The specified conditions differ
from file to file.

When you import component data from a .p2d or .s2d file into a General
Amplifier or General Mixer block, the block contains parameter values for
several operating conditions. The available conditions depend on the data in
the file. By default, the blockset defines the object behavior using the property
values that correspond to the operating conditions that appear first in the file.
To use other property values, you must select a different operating condition
in the block dialog box.

If the block contains data at multiple operating conditions, the Operating
Conditions tab contains two columns. The Conditions column shows the
available conditions, and the Values column contains a drop-down list of the
available values for the corresponding condition.
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Block Dialog Box Showing Operating Conditions

To specify the operating condition values for a simulation:

1 Double-click the block to open the block dialog box.
2 Select the Operating Conditions tab.

3 In the Conditions column, find the condition to specify. Select the
corresponding pull-down list in the Values column, and choose the desired

operating condition value.

Repeat the preceding step as needed to specify the desired operating condition
values.
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Model Nonlinearity

In this section...

“Amplifier and Mixer Nonlinearity Specifications” on page 4-24

“Add Nonlinearity to Your System” on page 4-25

Amplifier and Mixer Nonlinearity Specifications

You define nonlinearity for the physical amplifier and mixer blocks at one or
more frequency points through one of the following specifications:

® Power data, consisting of output power as a function of input power,
imported into the block.

¢ Third-order intercept data, with or without power parameters, in the block
dialog box. The available power parameters are gain compression power
(defined as the ratio of output power to input power at small input power)
and output saturation power.

The following table summarizes the nonlinearity specification options for each
type of physical amplifier and mixer block.

Block Nonlinearity Specification
General Amplifier You can choose either of the following
specifications:

® Power data (using a P2D, S2D, or
AMP data file)

¢ Third-order intercept data or one
or more power parameters, in the
block dialog box.

S-Parameters Amplifier Third-order intercept data or one or
more power parameters, in the block
dialog box.

Y-Parameters Amplifier

Z-Parameters Amplifier
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Block

Nonlinearity Specification

General Mixer

You can choose either of the following

specifications:

® Power data (using a P2D, S2D, or
AMP data file)

® Third-order intercept data or one

or more power parameters, in the
block dialog box.

S-Parameters Mixer
Y-Parameters Mixer

Z-Parameters Mixer

Third-order intercept data or one or
more power parameters, in the block
dialog box.

Add Nonlinearity to Your System

To simulate the nonlinearity of an amplifier or mixer, you must specify or
import nonlinearity data at one or more frequency points into the block.

The method you use to add nonlinearity data to a block depends on whether
you specify the data manually or import the data into a block.

The following table provides instructions for adding nonlinearity data.

Nonlinearity Specification

Instructions

1P3

In the Nonlinearity Data tab of the block
dialog box:

¢ Set the IP3 type parameter to IIP3 or
OIP3.

¢ Enter input third-order intercept values
at one or more frequency points in the
IP3 (dBm) parameter.

¢ Enter corresponding frequency values in
the Frequency (Hz) parameter.

Power parameters

Enter the gain compression power in the
1 dB gain compression power (dBm)
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Nonlinearity Specification | Instructions

parameter or the saturation power in
the Output saturation power (dBm)
parameter.

If you choose a scalar value for the
Frequency (Hz) parameter, then you
must also use scalar values for the power
parameters.

If you choose a vector value for the
Frequency (Hz) parameter, then you can
use either scalar or vector values for the
power parameters.

Power data (from a file) Import file data that includes power
information into the Data file or RFCKT
object parameter of the General Amplifier
or General Mixer block.

Note If you import file data with no power information into a General
Amplifier or General Mixer block, the Nonlinearity Data tab lets you add
nonlinearity data manually in the block dialog box.

For information on how the blockset simulates nonlinearity data of an
amplifier or mixer, see the block reference page.
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Model Noise

In this section...

“Amplifier and Mixer Noise Specifications” on page 4-27

“Add Noise to Your System” on page 4-28

“Plot Noise” on page 4-32

Amplifier and Mixer Noise Specifications

You only need to specify noise information for the physical amplifier and mixer
blocks that generate noise other than resistor noise. For the other blocks, the
blockset calculates the noise automatically based on the resistor values.

You define noise for the physical amplifier and mixer blocks through one of
the following specifications:

® Spot noise data in the data source.

® Spot noise data in the block dialog box.

® Spot noise data (rfdata.noise) object in the block dialog box.

® Frequency-independent noise figure, noise factor, or noise temperature
value in the block dialog box.

* Frequency-dependent noise figure data (rfdata.nf) object in the block
dialog box.

The following table summarizes the noise specification options for each type
of physical amplifier and mixer block.
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Block

Noise Specification

General Amplifier

Spot noise data (using a Touchstone,
P2D, S2D, or AMP data file)

OR

Spot noise data, noise figure value,
noise factor value, noise temperature
value, rfdata.noise, or rfdata.nf
object in the block dialog box

S-Parameters Amplifier
Y-Parameters Amplifier

Z-Parameters Amplifier

Spot noise data, noise figure value,
noise factor value, noise temperature
value, rfdata.noise, or rfdata.nf
object in the block dialog box

General Mixer

Spot noise data (using a Touchstone,
P2D, S2D, or AMP data file)

OR

Spot noise data, noise figure value,
noise factor value, noise temperature
value, rfdata.noise, or rfdata.nf
object in the block dialog box

S-Parameters Mixer
Y-Parameters Mixer

Z-Parameters Mixer

Spot noise data, noise figure value,
noise factor value, noise temperature
value, rfdata.noise, or rfdata.nf
object in the block dialog box

Add Noise to Your System

To simulate the noise of a physical subsystem, you perform the following tasks:

® “Specify or Import Noise Data” on page 4-28

¢ “Add Noise to the Simulation” on page 4-30

Specify or Import Noise Data

The method you use to add noise data to a block depends on whether you are
specifying noise data manually or importing spot-noise data.
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The following table provides instructions for adding noise data.

Noise Specification

Instructions

Frequency-independent noise figure

In the Noise Data tab of the block
dialog box, set the Noise type
parameter to Noise figure, and
enter the noise figure value in the
Noise figure (dB) parameter.

Frequency-dependent noise figure

In the Noise Data tab of the block
dialog box, set the Noise type
parameter to Noise figure, and
enter the name of the rfdata.nf
object in the Noise figure (dB)
parameter.

Noise factor

In the Noise Data tab of the block
dialog box, set the Noise type
parameter to Noise factor, and
enter the noise factor value in the
Noise factor parameter.

Noise temperature

In the Noise Data tab of the block
dialog box, set the Noise type
parameter to Noise temperature,
and enter the noise temperature
value in the Noise temperature
(K) parameter.

Spot noise data (in a block dialog
box)

In the Noise Data tab of the block
dialog box, set the Noise type
parameter to Spot noise data.
Enter the spot noise information in
the Minimum noise figure (dB),
Optimal reflection coefficient,
and Equivalent normalized noise
resistance parameters.
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Noise Specification Instructions

Spot noise data (from a data object) | In the Noise Data tab of the block
dialog box, set the Noise type
parameter to Noise figure and
enter the name of the rfdata.noise
object in the Noise figure (dB)
parameter.

Spot noise data (from a file) Import file data that includes noise
information into the Data file or
RFCKT object parameter of the
General Amplifier or General Mixer

block.

Note If you import file data with no noise information into a General
Amplifier or General Mixer block, the Noise Data tab lets you add noise
data manually in the block dialog box.

Add Noise to the Simulation
To include noise in the simulation, you must select the Add noise check box
on the Input Port block dialog box. This check box is selected by default.
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=] Block Parameters: Input Port x|

—Input Port
Connection blodk from Simulink to RF Blodkset physical blodks.

The RF Blockset physical blocks use a baseband-equivalent modeling technigue.
This technigue models a bandwidth of 1/(Sample time), centered at the spedfied
Center frequency parameter value. This frequency value corresponds to 0 Hz in
the baseband-equivalent model,

The blodk provides the option to interpret the Simulink signal as either the inddent
power wave to the RF system or the source voltage of the RF system, The
'Incident power wave' option is the most common RF modeling interpretation,

while the "Source voltage' option is provided for backwards compatibility. If the
input Simulink signal is the incident power wave, the output of the RF system is the
transmitted power wave. If the input is the source voltage, the output

is the load voltage.

The blodk controls the modeling of RF Blockset physical blocks between this blodk
and the Output Port blodk using:

- FIR filters to model the freguency-dependent characteristics

- Look-up tables to model the nonlinear behaviors

Optional guard bands can be specified as a fraction of the modeling bandwidth.
The guards bands are implemented by applying a Tukey window to the frequency
response, Modeling delay may be added to improve the response of the FIR filters,

—Parameters
Treat input Simulink signal as: ISnurce voltage :I
Source impedance (ohms): I 50

Finite impulse response filter length: I 128

Fractional bandwidth of quard bands: ID

Modeling delay (samples): ID
Center frequency (Hz): I 2e8
Sample time (s): I 1e-7
¥ Add noise
Initial seed: |67287

oK I Cancel | { Help | Apply

Select this check box to
take the noise data in
the physical blocks into
account. This check box
is selected by default.

For information on how the blockset simulates noise, see “Model Noise in

an RF System” on page A-7.
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Plot Noise

SimRF Equivalent Baseband software models communications systems.

The noise in these systems has a very small amplitude, typically from 1le-6

to le-12 Watts. In contrast, the default signal power of a Communications
System Toolbox modulator block is 1 Watt at a nominal 1 ohm. Therefore, the
signal-to-noise ratio in an RF system simulation is large, making it difficult to
view the noise that the RF system adds to your signal.

To display the noise on a plot, you might need to attenuate the signal
amplitude to a value within a couple orders of magnitude of the noise.

For example, suppose you have the following model that contains a multitone

test signal source.
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When you simulate this model, Simulink brings up several windows showing
the input and output for the physical subsystem. The Input - Frequency

Domain window shown in the following figure displays the input signal in
the frequency domain.
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File Axes Channels Window Help u

1}

-&0

Magnitude, dB

-100

-150

-015 -0 -0.08 4] 0.08 o 018
Frequency (GHz)

Input Signal Spectrum

The Real Part of Input - Time Domain window displays the real part of the
complex-valued input signal in the time domain.
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In the model, the physical subsystem adds noise to the input signal. The

Output - Frequency Domain window shows the noisy output signal in the
frequency domain.
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The amplitude of the signal is large compared to the amplitude of the noise,
so the noise is not visible in the Real Part of Output - Time Domain window
that shows the real part of the time-domain output signal. Therefore, you
must attenuate the amplitude of the input signal to display the noise of the
time-domain output signal.
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Real Part of Output Signal

Attenuate the amplitude of the input signal by setting the Gain parameter
to 1e-3. This is equivalent to attenuating the input signal by 60 dB. When
you run the model again, the two signal peaks are not as pronounced in the
Output - Frequency Domain window.
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You can now view the noise that the RF system adds to your signal in the Real
Part of Output - Time Domain window.
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® “Create Plots” on page 5-2

e “Update Plots” on page 5-27

e “Modify Plots” on page 5-28

® “Create and Modify Subsystem Plots” on page 5-31
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Create Plots

In this section...

“Available Data for Plotting” on page 5-2

“Validate Individual Blocks and Subsystems” on page 5-3
“Types of Plots” on page 5-3

“Plot Formats” on page 5-5

“How to Create a Plot” on page 5-14

“Example — Plot Component Data on a Z Smith Chart” on page 5-22

Available Data for Plotting

SimRF Equivalent Baseband software lets you validate the behavior of
individual RF components and physical subsystems in your model by plotting
the following data:

e Large- and small-signal S-parameters

* Noise figure, noise factor and noise temperature

¢ Qutput third-order intercept point

* Power data

® Phase noise

® Voltage standing-wave ratio

¢ Transfer function

¢ Group delay

e Reflection coefficients
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Note When you plot information about a physical block, the blockset plots
the actual frequency response of the block, as specified in the block dialog box.
The blockset does not plot the frequency response of the complex-baseband
model that it uses to simulate the block, in which the frequency response is
centered at zero. For more information on how the blockset simulates physical
blocks, see Appendix A, “SimRF Equivalent Baseband Algorithms”.

Validate Individual Blocks and Subsystems

You can plot model data for an individual physical block or for a physical
subsystem. A subsystem is a collection of one or more physical blocks
bracketed by an Input Port block and an Output Port block. To understand
the behavior of specific subsystems, plot the data of the corresponding Output
Port block after you run a simulation.

To validate the behavior of individual RF components in the model, plot the
data of the corresponding physical blocks. You can plot data for individual
blocks from each of these components either before or after you run a
simulation.

You create a plot by selecting options in the block dialog box, as shown in
“Create and Modify Subsystem Plots” on page 5-31. To learn about the
available plots, see “Types of Plots” on page 5-3. For more information about
creating plots, see “How to Create a Plot” on page 5-14.

Types of Plots

SimRF Equivalent Baseband software provides a variety of plots for analyzing
the behavior of RF components and subsystems. The following table
summarizes the available plots and charts and describes each one.
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Plot Type

Plot Contents

X-Y Plane
(Rectangular) Plot

Parameters as a function of frequency, input power,
or operating condition, such as
® S-parameters

® Noise figure (NF), Noise factor (NFactor), and
Noise Temperature (NTemp)

¢ Voltage standing-wave ratio (VSWR)
¢ Qutput third-order intercept point (OIP3)

¢ Input and output reflection coefficients
(Gammaln and GammaOut)

Link Budget Plot
(3-D)

Parameters as a function of frequency for each
component in a physical subsystem

where

The curve for a given component represents the
cumulative contribution of each RF component
up to and including the parameter value of that
component.

For more information, see “Link Budget” on page
5-11.

Polar Plane Plot

Magnitude and phase of parameters as a function of
frequency or operating condition, such as
® S-parameters

¢ Input and output reflection coefficients
(Gammaln and GammaOut)

Smith® Chart

Real and imaginary parts of S-parameters as a
function of frequency or operating condition, used
for analyzing the reflections caused by impedance
mismatch.

Composite Plot

Multiple plots and charts in one figure.

To learn how to create these plots, see “How to Create a Plot” on page 5-14.
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Plot Formats

When you create a plot from a block dialog box, you must specify the format of
the data for both the x- and y-axes.

Source of hiequancy dala: |'S‘ame az lhe sparameles: leouency j
Frequence data fHzl: (19531 0eB2 209
Reference impedance [chins): [5)
Fotlme P plone =l Plot format of first
' parameter]: m *f formall: ,m dependent variable
¥ parameterd: = vz [ =] — mﬂgﬁ:&?d
H parameter ’m # fommat ’m Plot format of
' scale: Linzar w|  Hscale Linear hd independent variable

These plot options define how SimRF Equivalent Baseband software displays
the data on the plot.

The available formats vary with the data you select to plot. The data you can
plot depends on the plot type you select. The plot formats determine whether
the blockset converts the data to a new set of units, or performs a calculation
on the data. For example, setting the format to Real tells the blockset to
compute and plot the real part of the parameter.

The following topics describe the available parameters and formats for each
plot type:

* “Composite Data” on page 5-5

e “X.Y Plane” on page 5-8

e “Link Budget” on page 5-11

e “Polar Plane Plots and Smith Charts” on page 5-13

Composite Data

The composite data plot automatically generates four separate plots in one
figure window, showing the frequency dependence of several parameters. The
following figure shows an example of such a plot.
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Example — Composite Data Plot

Note For composite data plots, you do not need to specify the parameters or
the formats—they are set automatically.

The combination of plots differs based on the type of block and the specified
block data. The following table describes the contents of the composite data
plot for each specification. The Plot Contents column lists the types of plots
as they appear on the composite plot, counterclockwise and starting in the
upper-left corner. The blockset plots all data as a function of frequency.
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Block Specified Data Plot Contents
General Network parameters ® X-Y plot, magnitude of S ,
AmGI‘r)lifier1 OR and S,, in decibels
or Genera
Mixer Network parameters and ° .X_Y plot, phase of 5,, and S,
. in degrees
noise
® 7 Smith Chart, real and
imaginary parts of S;; and S,,
e Polar plot, magnitude and
phase of S;; and S,,
Network parameters and ¢ X-Y plot, magnitude of S,,
power and S,, in decibels
OR ¢ X-Y plot, output power (P, )
. in dBm (decibels referenced
Network parameters, noise, -
to one milliwatt)
and power
e 7 Smith Chart, real and
imaginary parts of S;; and S,,
¢ Polar plot, magnitude and
phase of S|, and S,,
Other Network parameters ® X-Y plot, magnitude of S ,
Physical OR and S,; in decibels
block

Network parameters
and noise (S-, Y-, and
Z-Parameters Amplifiers
and Mixers only)

Note Only the General
Amplifier and General
Mixer blocks accept power
data.

® X-Y plot, phase of S;, and S,
in degrees

® 7 Smith Chart, real and
imaginary parts of S;; and S,,

e Polar plot, magnitude and
phase of S}, and S,,
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X-Y Plane

You can plot any parameters that are relevant to your block on an X-Y plane
plot. For this type of plot, you specify data for both the x- and y-axes. If you
specify two Y parameters, and you specify different formats for the two Y
parameters, the blockset plots the second Y parameter on the right y-axis.

The following table summarizes the available Y parameters and formats. The
parameters and formats are the same for both the left and right y-axes.

Note LS11,LS512,L821, and LS22 are large-signal S-parameters. You can plot
these parameters as a function of input power or as a function of frequency.

Y Parameter

Y Format

S11, §12, S21, S22

LS11, LS12, LS21, LS22 (General
Amplifier and General Mixer blocks
with multiple operating conditions
only)

Magnitude (decibels)
Magnitude (linear)
Angle (degrees)
Angle (radians)

Real

Imaginary

NF

Magnitude (decibels)

NFactor

None

This format tells the blockset to plot
the noise factor as it is specified to or
calculated by the block.

NTemp

Kelvin

0IP3

dBm
dBw
w
mW

VSWRIn, VSWROut

Magnitude (decibels)

None

This format tells the blockset to plot
the voltage standing-wave ratio as
it is specified to or calculated by the
block.
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Y Parameter Y Format
Pout (General Amplifier and General | dBm
Mixer blocks with power data only) | dBW

W

mw

Phase (General Amplifier and
General Mixer blocks with power
data only)

Angle (degrees)
Angle (radians)

AM/AM (General Amplifier and
General Mixer blocks with power
data only)

Magnitude (decibels)

None

This format tells the blockset to
plot the AM/AM conversion as it
1s specified to or calculated by the
block.

AM/PM (General Amplifier and
General Mixer blocks with power
data only)

Angle (degrees)
Angle (radians)

PhaseNoise (Mixer blocks only)

dBc/Hz

FMIN (Amplifier and Mixer blocks
with spot noise data only)

Magnitude (decibels)

None

This format tells the blockset to
plot the minimum noise figure as it
1s specified to or calculated by the
block.

GammaIn, GammaOut(Output Port
block only)

Magnitude (decibels)
Magnitude (linear)
Angle (degrees)
Angle (radians)

Real

Imaginary
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Y Parameter

Y Format

GAMMAOPT (Amplifier and Mixer
blocks with spot noise data only)

Magnitude (decibels)
Magnitude (linear)
Angle (degrees)
Angle (radians)

Real

Imaginary

RN (Amplifier and Mixer blocks with
spot noise data only)

None

This format tells the blockset to plot
the noise resistance as it is specified
to or calculated by the block.

The available X parameters depend on the Y parameters you select. The
following table summarizes the available X parameters for each of the Y

parameters in the preceding table.

Y Parameter

X Parameter

Pout, Phase, LS11,LS12, LS21, LS22 | Pin
Freq

S11, §12, S21, S22, NF, OIP3, VSWRIn, | Freq

VSWROut, GAMMAIn, GAMMAOut, FMIN,

GAMMAOPT, RN

AM/AM, AM/PM AM

The following table shows the X formats that are available for the X
parameters listed in the preceding table.
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X Parameter X Format

Pin dBm
dBw
w
mW

Freq THz

GHz

MHz

KHz

Hz

Auto (xformat is chosen to provide
the best scaling for the given
xparameter values.)

AM Magnitude (dB)
Magnitude (linear)

When you import block data from a .p2d or .s2d file, you can also plot Y
parameters as a function of any operating condition from the file that has
numeric values, such as bias. You can specify an operating condition as the X
parameter only when validating individual blocks, and the format is always
None. This format tells the blockset to plot the operating condition values as
they are specified in the file.

Link Budget

You use the Link budget plot to understand the individual contribution of
each block to a plotted Y parameter value in a physical subsystem with
multiple components between the Input Port and the Output Port blocks.

The link budget plot is a three-dimensional plot that shows one or more curves
of parameter values as a function of frequency, ordered by the subsystem

circuit index.

The following figure shows how the circuit index is assigned to a component
in a physical subsystem based on its sequential position in the subsystem.
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| | Component | |  Component Component | |
Input Port (Index = 1) (Index = 2) ooo (Index = n) Output Port

A curve on the link budget plot for each circuit index represents the
contributions to the parameter value of the RF components up to that index.
The following figure shows an example of a link budget plot.

) cascaded_system/Dutput Port3 o ] 3]
-

File Edt View Insert Tools Deskiop Window Help

Dedalr @aaae|E|/0B[=0

m=350

Contributions to S21
from components
1,2,and 3

Contributions to S21
from components
1and 2

821 [Magnitude (decibels)]

Contributions to S21
from component 1

26
Freq [GHz] Index of the circuit

Example — Link Budget Plot

The following table summarizes the Y parameters and formats that are
available for a link budget plot.

Y Parameter Y Format

S11, §12, S21, S22 Magnitude (decibels)
Magnitude (linear)
Angle (degrees)

Real

Imaginary

0IP3 dBm
dBw
W
mw
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Y Parameter Y Format

NF Magnitude (decibels)
Magnitude (linear)

NFactor None
This format tells the blockset to plot
the noise factor as it is specified to
the block.

NTemp Kelvin

If you specify two Y parameters, the blockset puts both parameters in a single
plot. The Y parameters must have the same formats.

For a link budget plot, the X parameter is always Freq. The format of the X
parameter specifies the units of the x-axis.

Polar Plane Plots and Smith Charts

You can use SimRF Equivalent Baseband software to generate Polar plots and
Smith Charts. When you select these plot types, you do not need to specify the
format of any Y parameters—the formats are set automatically. If you specify
two Y parameters, the blockset puts both parameters in a single plot.

The following table describes the Polar plot and Smith Chart options. It also

lists the available Y parameters.

Plot Type

Y Parameter

Polar plane

S11, 812, S21, S22

LS11, LS12, LS21, LS22 (General
Amplifier and General Mixer blocks
with data from a P2D file only)

GammaIn, GammaOut (Output Port
block only)

Z Smith chart

S11, S22

LS11, LS22 (General Amplifier and
General Mixer blocks with data from
a P2D file only)
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Plot Type

Y Parameter

GammalIn, GammaOut (Output Port
block only)

Y Smith chart

S11, S22

LS11, LS22 (General Amplifier and
General Mixer blocks with data from
a P2D file only)

GammalIn, GammaOut (Output Port
block only)

ZY Smith chart

S11, S22

LS11, LS22 (General Amplifier and
General Mixer blocks with data from
a P2D file only)

GammalIn, GammaOut (Output Port
block only)

How to Create a Plot

By default, the X parameter is Freq. The format of the X parameter specifies
the units of the x-axis. When you import block data from a .p2d or .s2d file,
you can also plot Y parameters as a function of any operating condition from
the file that has numeric values, such as bias. You can specify an operating
condition as the X parameter only when validating individual blocks, and
the format is always None.

1 Double-click the block to open the block dialog box, and select the

Visualization tab. The following figure shows the contents of the tab.
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Source of frequency data: |E:-:tracteu:| fram data source j

Frequency data [Hz): |[‘| 29182 Se5)
Source of input power data: |E:-:lracleu:| fram data source j

Ihput power data [dBm]: |[D:1 9]
Reference impedance [ohms): |5EI
Flat type: |><-Y' plane j
' parameter]: 511 | ¥ format]: IMagnitude [decibelz) j
' parameter?; I VI ¥ formats: I ﬂ
* parameter; IFreq VI * format; IHZ ﬂ
' gcale: ILineal VI = goale: ILineal LI

Filot |
2 Select the Source of frequency data.
Select the source

Source of frequency data: IEHllaCtEd from data source ;I — of frequencies

Frequency data [Hz): I['I &3 1e8:2 9e9] gltovéﬂlggtt: plot
Source of input power data: |E>:tracted fram data source ;I

Input power data [dBm]: I[D:1 9]
Reference impedance [ohms): |5EI
Flot tppe: IX-Y plare ;I
Y parameter]: Iﬁ ¥ formatl: IMagnitude [decibels] j
' paramekers: Iﬁ ¥ farmat2: | ;I
¥ parameter: Im # format: IHz ;I

Y scale: Linear | ¥ ecale: |Linear j

Flot |

This value is the source of the frequency values at which to plot block
data. The following table summarizes the available types of sources for
the various types of blocks.
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Source of
frequency
data

Description

Blocks

User-specified

Vector of frequencies that you
enter.

When you select
User-specified in the Source
of frequency data list, the
Frequency range (Hz)

field is displayed. Enter a
vector specifying the range of
frequencies you want to plot.

For example, to plot block
data from 0.3 MHz to 5
GHz by 0.1 MHz, enter
[0.3e6:0.1e6:5€9].

Note When you select
PhaseNoise in the Parameter
list and User-specified in the
Source of frequency data list,
the Frequency range (Hz)
field is disabled. You use the
Phase noise frequency offset
(Hz) block parameter to specify
the frequency values at which
to plot block data.

All physical blocks

Derived from
Input Port
parameters
(Available
after running
a simulation
or clicking
the Update

Modeling frequencies derived
from the Input Port block
parameters. For information
on how the blockset computes
the modeling frequencies,
see “Determine Modeling
Frequencies” on page A-3.

All physical blocks
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Source of
frequency
data

Description

Blocks

Diagram
button & )

Same as the
S-parameters

Frequency values specified
in the Frequency block
parameter.

S-Parameters
Passive Network,
S-Parameters
Amplifier,
S-Parameters Mixer

Same as the
Y-parameters

Frequency values specified
in the Frequency block
parameter.

Y-Parameters
Passive Network,
Y-Parameters
Amplifier,
Y-Parameters Mixer

Same as the
Z-parameters

Frequency values specified
in the Frequency block
parameter.

Z-Parameters
Passive Network,
Z-Parameters
Amplifier,
Z-Parameters Mixer

Extracted
from data
source

Frequency values imported
into the Data file or RFDATA
object block parameter.

General Passive
Network, General
Amplifier, and
General Mixer

3 Enter the Reference impedance.
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Source of frequency data; IEHllaCtEd from data zource ;I

Frequency data [Hz): I['I &3 1e8:2 9e9]
Source of input power data: |E>:tracted fram data source ;I

Input power data [dBm]: I[D:1 9] Enter the
Reference impedance [ohms): |5EI —— reference
Flot tppe: IX-Y plare ;I impedance

Y parameter]: |S11 "I ¥ formatl: IMagnitude [decibels] j
' paramekers: I vl ¥ farmat2: | ;I
¥ parameter: IFleq VI # format: IHz ;I

Y scale: Linear | ¥ ecale: |Linear j

Flot |

This value is the reference impedance to use when plotting small-signal
parameters.

4 Select the Plot type.

Source of frequency data: |Eﬂtrau:ted from data zource LI
Frequency data [Hz]: |[1 23 1e8:2 5929]

Saource of input power data; |EHtracted fram data saurce j
Input power data [dBm): I[EI:'I 9]

Reference impedance [ohms]: |5IJ

Plat type: |><-Y plare LI _— ?I%Itetcytptge
" parameter]: Im " formatd: IMagnitude [decibels) ;I

Y parameter?: Iﬁ Y format2: | j

¥ parameter; m * format; |H2 ;I

' soale: Im A scale: ILineal ;I

Plot |

This value is the type of plot. For a description of the options, see “Types
of Plots” on page 5-3.

5 Select the following parameters:

e Y Parameterl — The first parameter for the Y-axis.
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¢ Y Parameter2 — The second parameter for the Y-axis (optional).

e X Parameter — The parameter for the X-axis.

Saource of frequency data: |E:-:lrac:teu:| fram data zource LI
Frequency data [Hz): |[1 23:1ed:2 98]
Source of input power data: IE:-:trac:ted from data source ;I

|nput power data [dBm): |[EI:1 9]

Select the first Y-axis Heference impedance [chms]: |5EI

plot parameter Plat type: IX-Y plane ;I
. ' parameter]: 511 | % fomatl:  |Magnitude [decibels] =

Optionally, select I _I

the second Y-axis—— ' parameterZ: | v| ¥ fomat2: | |

plot parameter ,— * parameter: IFreq vl * farmat: IHz LI
W zcale; ILinear vl X zcale; |Linear ;I

Select the X-axis
Flat |

plot parameter
These parameters specify the data to be plotted. The available choices vary
with the type of plot. For a description of the options for a particular plot
type, see the topic on that plot type in “Plot Formats” on page 5-5.

If you select a large-signal parameter for one or more y-axis parameters,
select the Source of power data.

Note Large-signal parameters are available only for General Amplifier or
General Mixer blocks that contain power data.
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Source of frequency data: |E>:lrac:ted from data source j
Frequency data [Hz): I[‘I e9:1e8:2.9:4]
: Select the source
Source of input power data: IEHllaCtEd from data source ;I of input power
Input power data (dBm): |[D:'| 9] values at which

to plot block data

Reference impedance [ohms): |5EI

Flat type: |><-Y' plane j

Y parameter]; IF'DUT vl 7 formatl: dBm -
' parameters: I vl " format: I VI

¥, parameter: Pt - = format; dBm -

Y zcale; ILineal VI X scales ILinear VI
Pliat |

This value is the source of the input power values at which to plot block
data. The following table summarizes the available types of sources for the
General Amplifier and General Mixer blocks.

Source of frequency data Description

Extracted from data source Input power values imported into
the Data file or RFDATA object
block parameter.

User-specified Vector of power values that you
enter.

When you select User-specified
in the Source of power data list,
the Input power data (dBm)
field is displayed. Enter a vector
specifying the range of power
values you want to plot.

For example, to plot block data
from 1 dBm to 10 dBm by 2 dBm,
enter [1:2:10].

7 Select the following formats:
®* Y Formatl — The format for the first Y parameter.
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¢ Y Format2 — The format for the second Y parameter (optional).

¢ X Format — The format for the X parameter.

Source of frequency data; |E>:trau:ted from data zource j
Frequency data [Hz]: I['I e 1ed 2 924]
Source of input power data: |E>:lrac:ted from data saurce j

Input power data (dBm): I[D:'I 9] Select the format

Reference impedance [ohms): IEEI for Y parameter1
Plat type: |><-Y plare |
v parameterl; IS'H vl ' formatl; IMagnitude [decibels] ;I Optionally, select

Y pararneter: I "I Y farmatz: | ;I the format for
Y parameter2

¥, parameter: IFreq vl * farmat; |Hz ;I P

Y zcale; ILineal VI X scale: ILinear ;I l

Select the format
for X parameter

Fliat

These are the X and Y formats for plotting the selected parameter. The
available choices vary based on the selected parameter. For a description
of the options for a particular plot type, see the topic on that plot type in
“Plot Formats” on page 5-5.

8 Select the X Scale and Y Scale.
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Source of frequency data; IEHtlaCtEd from data zource ;I
Frequency data [Hz): |['| &3 1e8: 2 9e9]

Source of input power data: IEHtracted fram data source ;I
Input power data [dBm]: I[D:1 9]

Reference impedance [ohmsz): |5EI

Flat tppe: IX-Y plare ;I
Y parameter]: m % Farmat1: IMagnitude [decibelz] ;I
' parameters; Iﬁ v format: | ;I
¥ parameter: Im # format: |H2 ;I

Select the —— ¥ zcale: Linear | Hzcale |Linear j

Y-axis scale
Flat |

Select the
X-axis scale

These are the scales on which to plot the data. The available choices are
Linear and Log.

9 Click Plot.

Note By default, the blockset does not add a legend to some plots. To display
the plot legend, type legend show at the MATLAB prompt.

Example — Plot Component Data on a Z Smith Chart

In this example, you simulate the frequency response of an amplifier using
data from the default.s2d S2D file.

Using a SimRF Equivalent Baseband example model, you import the data
file into a General Amplifier block and validate the amplifier by plotting the
S-parameters of the block on a Z Smith Chart.

1 Type sparam_amp at the MATLAB prompt to open the “AMP Data File for
Amplifier” example.
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i
File Edit View Simulaton Format Tools Help
Ol HS| LB 4@ » sfio | [Nma ARshesn nEE®
Data File for Amplifier | E———— | ————— |
| Open default.s2d | Open defaultp2d |

Inipust
Compare File Formats
-
Input = N - Output Owrtpurt | | L IM
Tnput L 3 Part General Amplifier Fort =I BFFT
Wi P Baseband-Equivalent Spechrum
White Moise = = =
Input Port Genetaline ] Bey Cutput Port
o ] ®
GCenter Frequency: 2.1 GHz B-FFT
Passband Spectrum Infa
Copyright 2002-2008 The MathWorks, Inc.
Ready [100% [ [ |FixedStepDiscrete

2 Double-click the General Amplifier block to display its parameters.
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[Z1Block Parameters: General Amplifier x|

— General Amplifier

Manlinear amplifier described by a data source that consists of either an RFDATA object
or data from & file. D ata interpolation iz used during simulaticn.

Wihen there is no noise data in the data source, use the Moise D ata tab to specify
amplifier noize information.

when there iz ho nonlinearity data in the data source, use the Monlinearity Data tab to
zpecify amplifier nonlinearity information.

‘when the data source containg operating condition information, uze the Operating
Conditions tab to select operating condition settings for the simulation.

b airy | Moize Data I Monlinearity Data Wigualization I Operating Conditionsl

Data source: IData file LI

D ata file: Idefault. z2d Browse ... |

RFDATA object: Iread[rfdata.data, ‘default.amp’)
Interpolation methad: ILinear ﬂ

] I Caticel | Help | Aoply |

As shown in the preceding figure, the Data source parameter is set to
Data fileand the Data file parameter is set to default.s2d. These
values tell the blockset to import data from the file default.s2d. The block
uses this data, along with the other block parameters, in simulation.

3 Select the Visualization tab and set the General Amplifier block

parameters as follows:
¢ In the Plot type list, select Z Smith chart.
® In the Y Parameterl list, select S22.



Create Plots

=] Block Parameters: General Amplifier |

— General Amplifier

RF amplifier described by a data source that consists of either an RFDATA object or data
from a file.

When there is no noise data in the data source, use the Moise Data tab to specify amplifier
noise infarmation. For a frequency-dependent noise, the Noise Data tab accepts a separate
N-glement vector of the corresponding frequency values.

When there is no nonlinearity data in the data source, use the Monlinearity Data tab to
specify amplifier nonlinearity information. For & frequency-dependent nonlinearity, the
Nonlinearity Data tab accepts a separate N-glement vector of the corresponding frequency
values,

When the data source contains operating condition information, use the Operating
Conditions tab to select operating condition settings for the simulation.

Data interpalation is used during simulation.

Main Moise Data I Monlinearity Data Visualization | Operating Conditions I

Source of frequency data: IExtracted from data source j
Frequency data (Hz): I [1.0e9:1.0e8:2.5e9]
Source of input power data: IExt’acbed from data source ;I

Input power data (dBm): ID

Reference impedance {ohms): I 50

Flot type: IZ Smith chart j

' parameter 1: 522 ~| ' formatl: Ih
Y parameter2: Iﬁ Y format2: Iﬁ
X parameter: m ¥ format: Hz -

¥ scale: Im ¥ scale: Im

Flot |
OK I Cancel | Help | Apply |

4 Click Plot.

This action creates a Z Smith Chart of the S,, parameters using the
frequency data from the default.s2d file.
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-} untitled/General Amplifier = |EI|1|
File Edit Wiew Insert Tools Desktop Window Help ]

Desd&| h|a s 0E O

70 =50 +1.0

1.0

General Amplifier Frequency Response

Note To display data tips for a plotted line, select Tools > Data Cursor.
Click the data cursor on the plotted line to see the frequency and the
parameter value at that point. See the MATLAB documentation for more
information.
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Update Plots

When you run a simulation, the blockset continues to display any open plots,
but does not update the plots to reflect new simulation results. You must
update the subsystem plots after the simulation to display the behavior of
the revised subsystem.

When you make changes to the parameters of blocks that represent individual
RF components, you need to update any open plots, because the blockset does
not automatically redraw the plots.

To update an existing plot:

1 Double-click the block to open the block dialog box, and select the
Visualization tab.

[=]Block Parameters: Dutput Pork x|

Output Port:

Connection block from RF Blockset phyzsical blocks to Simulink.

After running a simulation, various parameters of the RF spstem that iz delimited by an
Irput Part Black and thiz Output Part black can be visualized.

Main  Yisualization I

Source of frequency data: IDerived from Input Port parameters LI

Frequency data [Hz): |1 e9:1e8:3e9

Fieference impedance [ohms): |5EI
Flat type: IComposite data j

Y parameter: 511 - Y format: IMagnitude [decibelz] vl
Y parameters: I vl Y formatz: I YI

* parameter; Freq -  format: Hz -

Y soale: Linear - K scale: ILinear VI
Plat |

ak. I Cancel | Help | Apply |

Example Block Dialog Box Showing Visualization Tab

2 Click Plot.
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Modify Plots

You can modify an existing plot by changing the plot options. The outcome
depends on the parameter you change.

The following table summarizes the results of changing the plot options.

Block Parameter

Plot Change

Source of frequency
data

OR
Frequency data (Hz)

Redraws plot using the new frequency data.

Source of power data
OR

Input power data
(dBm)

Redraws plot using the new power data.

Plot type

Draws plot in a new figure using the new plot
type.

Note If the current plot options are valid for
the new plot type, they retain their values.
Otherwise, they revert to their default values.

Y Parameterl
OR

Y Parameter2

If the new parameter has the same independent
variable and format as the one on the plot, the
blockset adds the new parameter to the existing
plot. Otherwise, it redraws the plot for the new
parameter and independent variable.

Y Formatl
OR
Y Format2

Redraws plot using the new format.
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Block Parameter Plot Change

X Parameter Redraws plot using the new independent
variable.

X Format Redraws plot using the new format.

X Scale Redraws plot using the new scale.

Y Scale Redraws plot using the new scale.

To modify a plot:

1 Double-click the block to open the block dialog box, and select the
Visualization tab.
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[Z1Block Parameters: General Amplifier x|

— General Amplifier

Monlinear amplifier dezcribed by a data source that consists of either an RFDATA
object or data from a file. Data interpalation is used during simulation,

“‘when there is no noize data in the data source, use the Moise Data tab to specify
amplifier noize information.

when there iz no nonlinearity data in the data source, use the Monlinearity Data tab to
specify amplifier nonlinearity information.

when the data zource containg operating condition infarmation, uze the Operating
Conditions tab to select operating condition settings for the: zimulation.

tain Moize Data I Monlinearity Data isualization Operating Conditions

Source of frequency data; IExtracted from data source ;I
Frequency data [Hz]: |[1 e 1ed:2 9:9]
Source of input power data: IExtracted from data source LI

Input power data [dEm): I[U:1 9]

Reference impedance [ohms): IED

Flot type: |><-Y plane LI
' parameter]: 511 - ' formatl: IW
't parameter?: lﬁ ' format2: Iﬁ
* parameter: m * format: m
' soale: m # soale: Im

Plat |

Ok I Cancel | Help | Apply |

Example Block Dialog Box Showing Plot Parameters

2 Change the plot options.

3 Click Plot.
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Create and Modify Subsystem Plots

In this section...

“Plot the Network Parameters of a Subsystem” on page 5-31
“Add Data to an Existing Plot” on page 5-33

“Change Data on an Existing Plot” on page 5-35

Plot the Network Parameters of a Subsystem

In this part of the example, you open and run a SimRF Equivalent Baseband
example that uses file data to specify an amplifier in a physical subsystem.
Then, you plot the network parameters of the physical subsystem, which
consists of the General Amplifier, the Input Port, and the Output Port blocks.

1 Type sparam_amp at the MATLAB prompt to open the SimRF Equivalent
Baseband example called “AMP Data File for Amplifier”.

2 In the model window, select Simulation > Start to run the simulation.
Once the simulation has reached steady state, select Simulation > Stop
to stop the simulation.

3 Double-click the Output Port block to open the block dialog box.

4 Select the Visualization tab and set the Output Port block parameters as
follows:

¢ In the Source of frequency data list, select Derived from Input
Port parameters.

® In the Plot type list, select X-Y plane.
¢ In the Y Parameterl list, select S21.
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[ Block Parameters: Output Port x|

Output Port:

Connection block from RF Blockset physical blocks to Simulink.

After running a simulation, various parameters of the RF system that is delimited by an Input
Port black and this Output Port block can be wisualized.

Main Visualization I

Source of frequency data: IDerived from Input Port parameters LI

Frequency data (Hz): I 129 128:3e9

Reference impedance (ohms): I 50

Plot type: IXY plane LI
Y parameter1: Im ' format1: Im
'f parameter2: Iﬁ Y format2: Iﬁ
X parameter: m ¥ format: Ih
¥ scale: Im ¥ scale: Im

Plot |
oK I Cancel | Help | Apply |

5 Click Plot.

This action plots the magnitude of S,, (in decibels) as a function of
frequency on an X-Y plot.
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SIEl]
=

File Edit view Insert Tools Desktop Window Help
N ALK RO EL- 20D

Z0= 50

29

@ -~ ®

Magnitude {decibels)

o

2
185 1.9 1.95 2 205 241 215 22 225 23 235
Freg [GHz]

S,, versus Frequency for a Physical Subsystem

Add Data to an Existing Plot

In this part of the example, you add data to the plot you created in “Plot the
Network Parameters of a Subsystem” on page 5-31.

1 Double-click the Output Port block to open the block dialog box.

2 Select the Visualization tab and change the value of Y Parameterl to
S22.
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[ Block Parameters: Output Port x|

Output Port:

Connection block from RF Blockset physical blocks to Simulink.

After running a simulation, various parameters of the RF system that is delimited by an Input
Port black and this Output Port block can be wisualized.

Main Visualization I

Source of frequency data: IDerived from Input Port parameters LI

Frequency data (Hz): I 129 128:3e9

Reference impedance (ohms): I 50

Plot type: IXY plane LI
' parameter1: 522 - ' format1: Im
'f parameter2: Iﬁ Y format2: Iﬁ
X parameter: m ¥ format: Ih
¥ scale: Im ¥ scale: Im

Plot |

oK I Cancel | Help | Apply

3 Click Plot.

This action adds S,, to the plot.
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S,, and S,, versus Frequency for a Physical Subsystem

Change Data on an Existing Plot

In this part of the example, you change the data on the plot you created in the
previous steps of the example by modifying the Plot type.

1 Double-click the Output Port block to open the block dialog box.

2 Select the Visualization tab and change the value of Plot type to Polar
plane, as shown in the following figure.

As the figure shows, the value of Y Parameterl remains as S,,, the last
parameter selected for the previous plot.
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Output Port:

Connection block from RF Blockset physical blocks to Simulink.

After running a simulation, various parameters of the RF system that is delimited by an Input
Port black and this Output Port block can be wisualized.

Main Visualization I

Source of frequency data: IDerived from Input Port parameters LI

Frequency data (Hz): I 129 128:3e9

Reference impedance (ohms): I 50
Plot type: IPoIar plane LI

Y parameter1: 522 b ' format1: Im
'f parameter2: Iﬁ Y format2: Iﬁ
X parameter: m ¥ format: Ih
¥ scale: Im ¥ scale: Im

Plot |
oK I Cancel | Help | Apply |

3 Click Plot.

This action creates a Polar plane plot of S,, as a function of frequency.
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4 In the Output Port block dialog box, change the Plot type to Composite
data to generate four plots in one figure. The parameters for the plots
are defined by the block, so the Y Parameterl, Y Parameter2, and X
Parameter fields becomes invisible.
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Output Port:

Connection block from RF Blockset phyzsical blocks to Simulink.

After running a simulation, various parameters of the RF spstem that iz delimited by an
Irput Part Black and thiz Output Part black can be visualized.

Main  Yisualization I

Source of frequency data: IDerived from Input Port parameters LI

Frequency data [Hz): |1 e9:1e8:3e9

Fieference impedance [ohms): |5EI

Flat type: IComposite data j
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Plat |

ak. I Cancel | Help | Apply |

5 Click Plot.

This action creates a composite plot.
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* “Determine Modeling Frequencies” on page A-3

e “Map Network Parameters to Modeling Frequencies” on page A-5
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® “Create a Complex Baseband-Equivalent Model” on page A-13

e “Convert to and from Simulink Signals” on page A-33
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Simulate an RF Model

When you simulate a model that contains physical blocks, SimRF Equivalent
Baseband software determines the modeling frequencies of the physical
system using the Input Port block parameters. The modeling frequencies
are the frequencies at which the blockset takes information from the blocks
to construct the baseband-equivalent model. Then, the software determines
the block parameter values at those frequencies and uses the information to
create a baseband-equivalent model for Simulink time-domain simulation.
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Determine Modeling Frequencies

When you simulate an RF model, the Output Port block uses Input Port block
parameters to determine the modeling frequencies f for the physical system
that is bracketed between the Input Port block and the Output Port block. fis
an N-element vector, where N is the finite impulse response filter length. The
modeling frequencies are a function of the center frequency f, and the sample
time ¢,. The following figure shows the Input Port block parameters that
determine the modeling frequencies.

E! Block Parameters: Input Port |

—Input Port

Connection block from Simulink to RF Blockset physical blocks.

The RF Blockset physical blocks use a baseband-equivalent modeling technigue.
This technigue models a bandwidth of 1/(Sample time), centered at the specified
Center frequency parameter value. This frequency value corresponds to 0 Hzin
the baseband-equivalent model.

The block provides the option to interpret the Simulink signal as either the incident
power wave to the RF system or the source voltage of the RF system. The
'Incident power wave' option is the most common RF modeling interpretation,

while the 'Source voltage' option is provided for backwards compatibility. If the
input Simulink signal is the incident power wave, the output of the RF system is the
transmitted power wave. If the input is the source voltage, the output

is the load voltage.

The block controls the modeling of RF Blockset physical blocks between this block
and the Output Port block using:

- FIR filters to model the frequency-dependent characteristics

- Look-up tables to model the nonlinear behaviors

Optional guard bands can be spedified as a fraction of the modeling bandwidth.
The guards bands are implemented by applying a Tukey window to the frequency
response. Modeling delay may be added to improve the response of the FIR filters.

—Parameters
Treat input Simulink signal as: ISource voltage LI
Source impedance (ohms): I 50
Finite impulse response filter length: I 128 N

Fractional bandwidth of guard bands: ID

Modeling delay (samples): ID
Center frequency (Hz): I 2ed fe
Sample time (s): I le-7 ts
¥ add noise

Initial seed: |67987

oK I Cancel |

Apply
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f, is the nth element of the vector of modeling frequencies, f, and is given by

n-1
fn :fmin +tS_N n=l,...,N
where
1
fmln _fc_g
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Map Network Parameters to Modeling Frequencies

In a physical system, each block provides network parameters at
different frequencies. These frequencies are not necessarily the modeling
frequencies for the physical system in which the block resides. To create
a baseband-equivalent model, SimRF Equivalent Baseband software must
calculate the values of the S-parameters at the modeling frequencies.

Individual physical blocks calculate the S-parameters at the modeling
frequencies determined by the Input Port block parameters. Each block
interpolates its S-parameters to determine the S-parameters at the modeling
frequencies. If the block contains network Y- or Z-parameters, it first converts
them to S-parameters.

Specifically, the block orders the S-parameters in the ascending order of their
frequencies, f,. Then, it interpolates the S-parameters using the MATLAB
interp1 function. For example, the curve in the following diagram illustrates
the result of interpolating the S, parameters at original frequencies f;

through f..
Interpolated S, parameter values
B A/‘7 Original S, parameter values
f, f, fy fs f;<—— Frequencies in ascending
order of magnitude
(fmin) (fmax)

The Interpolation method field in the individual block dialog boxes enables
you to specify the interpolation method as Cubic, Linear (default), or Spline.
For more information about these methods, see the interp1 reference page in
the MATLAB documentation.

As shown in the previous diagram, each block uses the parameter values
at f, ., for all modeling frequencies smaller than f, .. The block uses the
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parameter values at f, _for all modeling frequencies greater than f, . In
both cases, the results may not be accurate, so you need to specify network
parameter values over a range of frequencies that is wide enough to account

for the block behavior.
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Model Noise in an RF System

The SimRF Equivalent Baseband Physical library blocks can model noise. The
Input Port block parameters specify whether to include noise in a simulation.
When you include noise information in your model, the blockset simulates the
noise of the physical system by combining the noise contributions from each
individual block. This section explains how the blockset simulates noise from
user-specified information. For information on how to add noise to an RF
model, see “Model Noise” on page 4-27.

In this section...
“Output-Referred Noise in RF Models” on page A-7

“Calculate Noise Figure at Modeling Frequencies” on page A-10
“Calculate System Noise Figure” on page A-11
“Calculate Output Noise Power” on page A-12

Output-Referred Noise in RF Models

In general, you can specify output-referred noise in one of three ways:

® Noise temperature — Specifies the noise in kelvin.

® Noise factor — Specifies the noise by the following equation:

Noise temperature
290

Noise factor = 1+

® Noise figure — Specifies the noise in decibels relative to the standard
reference noise temperature of 290 K. In terms of noise factor

Noise figure = 10log(Noise factor)

These three specifications are equivalent, because you can compute each
one from any of the others.

The blockset lets you simulate the noise associated with any physical block in
your RF model.

A-7
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The blockset automatically determines the noise properties of passive blocks
from their network parameters. The blockset gets these network parameters
either explicitly from the block dialog box or specified data files, or implicitly
by calculating them from the specified block parameters.

For active devices such as amplifiers and mixers, the noise properties can
not be inferred from network parameters. Therefore, for the amplifier and
mixer blocks, you must specify the noise information explicitly, either in the
dialog block or the associated data file.

For physical amplifier and mixer blocks, you can specify active block noise
in one of the following ways:

® Spot noise data

* Frequency-independent noise figure, noise factor, or noise temperature
values

* Frequency-dependent noise figure data (rfdata.nf) or spot noise data
(rfdata.noise) object

These noise specification options are described in “Amplifier and Mixer Noise
Specifications” on page 4-27.

When you run the simulation, the blockset first computes the noise figure
values for each individual block at the modeling frequencies. Then, it
computes the noise figure of the physical system from the individual noise
figure values and uses the system noise figure information to calculate the
output noise power. This process is shown in the following figure.



Model Noise in an RF System

Select this check box

to include noise data

in the simuliation ———— =

E!amp_qamIE_mudEI,.-"RF Rereiver

=] Block Parameters: RF In

T Lot Patt—m 0 —————— — —

Source impedance:

v Add noize

|nitial zeed:

e . - e,

|50

67387

Cancel |

Heb |
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—

System Noise
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Calculate Noise Figure at Modeling Frequencies

To include noise information in a simulation, the blockset must compute the
noise figure values of each individual block at the modeling frequencies.

If you specify the frequency-independent noise figure value directly, or if
the blockset computes the noise figure value from the block resistance, the
blockset uses this value for the noise figure value at each of the modeling
frequencies.

If you specify the noise factor or noise temperature value, the blockset
computes the noise figure value from the specified value using the equations
in the preceding section and uses the computed value for the noise figure
value at each of the modeling frequencies.

If you specify frequency-dependent noise figure values using an rfdata.nf
object, the blockset interpolates the values using the Interpolation method
specified in the block dialog box to get the noise figure value at each of the
modeling frequencies.

If you specify spot noise data, the blockset computes frequency-dependent
noise figure information from this data. It takes the minimum noise figure,
NF ., equivalent noise resistance, I, and optimal source admittance,

min?®

Yopt, values in the file and interpolates to find the values at the modeling

frequencies. Then, the blockset uses the following equation to calculate the
noise correlation matrix, C,:

Rn NFm2in -1 - RnYopt*
Cy =2kT NF 1 )
— RnYopt Rn |Yopt|

2

where & is Boltzmann’s constant, and 7T is the noise temperature in Kelvin.

The blockset then calculates the noise factor, F, from the noise correlation
matrix as follows:
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N 27Cy2
2kTRe{Zg}

o

In the two preceding equations, Z is the nominal impedance, which is 50
ohms, and z* is the Hermitian conjugation of z.

The blockset obtains the noise figure, NF, from the noise factor:

NF =10log(F)

Calculate System Noise Figure

The blockset uses a recursive process to calculate system noise figure. The
noise correlation matrices for the first two elements of the cascade are
combined into a single matrix, and the process is repeated.

The following figure shows a cascaded network consisting of two 2-port
networks, each represented by its ABCD-parameters.

| 5
c o . c" Do

First, the blockset calculates noise correlation matrices C,”and C,” for the two
networks. Then, the blockset combines C,"and C," into a single correlation
matrix C, using the equation

’ .A.’ B’ 7 A, B,
=C C
Cp=Cy+ {C’ D’] A [ c D’}

The ABCD-parameter matrices in the cascade combine according to matrix
multiplication:
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A-12

A B B Al Bl All B//
C D - C/ D/ C” D/l

If there is another element in the cascade, the same calculations will be
performed using these ABCD-parameters as well as the ABCD-parameters
corresponding to the following element. The recursion will terminate with a
noise correlation matrix pertaining to the entire system. The blockset then
calculates the system noise figure from this matrix.

For more information about these calculation techniques, see the following
article:

Hillbrand, H. and P.H. Russer, “An Efficient Method for Computer Aided
Noise Analysis of Linear Amplifier Networks,” IEEE Transactions on Circuits
and Systems, Vol. CAS-23, Number 4, pp. 235238, 1976.

Calculate Output Noise Power

The blockset uses noise power to determine the amplitude of the noise that
it adds to the physical system using a Gaussian distributed pseudorandom
number generator. It uses both the noise temperature and the modeling
bandwidth to calculate the noise power:

Noise power = kTB

where & is Boltzmann’s constant, 7' is the noise temperature in Kelvin, and
B is the bandwidth in hertz.

The blockset computes noise temperature from the specified or calculated
noise figure values for the system, and it computes the modeling bandwidth
from the model’s sample time and center frequency.
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Create a Complex Baseband-Equivalent Model

In this section...

“Baseband-Equivalent Modeling” on page A-13
“Simulation Efficiency of a Baseband-Equivalent Model” on page A-18

“Example — Select Parameter Values for a Baseband-Equivalent Model”
on page A-19

Baseband-Equivalent Modeling

SimRF Equivalent Baseband software simulates the physical system in the
time domain using a complex baseband-equivalent model that it creates from
the passband frequency-domain parameters of the physical blocks. This type
of modeling is also known as lowpass equivalent (LPE), complex envelope,
or envelope modeling.

To create a complex baseband-equivalent model in the time domain based
on the network parameters of the physical system, the blockset performs a
mathematical transformation that consists of the following three steps:

1 “Calculate the Passband Transfer Function” on page A-13
2 “Calculate the Baseband-Equivalent Transfer Function” on page A-16

3 “Calculate the Baseband-Equivalent Impulse Response” on page A-16

Calculate the Passband Transfer Function

The blockset calculates the passband transfer function from the physical
block parameters at the modeling frequencies by calculating the transfer
function of the physical subsystem and then applying the Tukey window to
obtain the passband transfer function.

Note To learn how the blockset uses the specified network parameters
to compute the network parameters at the modeling frequencies, see “Map
Network Parameters to Modeling Frequencies” on page A-5.

A-13



A Simrev Equivalent Baseband Algorithms

The transfer function of the physical subsystem is defined as:

Vi.(f)
Vs(f)

H(f) =

where Vg and V, are the source and load voltages shown in the following
figure, and f represents the modeling frequencies.

Physical

Vs Vin | Subsystem

More specifically,

Sp1 (1+1)(1-T5)

H(f)=
2(1-Sgol; )(1-T,I'y)
where
Fl — Zl _ZO
Zl +Z0
Fs — Zs _Zo
Z,+2Z,
T
Tin =511 +[312521 m]
and

e 7.1s the source impedance.
S p

® Z, is the load impedance.
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* S, are the S-parameters of a two-port network.

The blockset derives the transfer function of the physical subsystem from the
Input Port block parameters as shown in the following figure.

Passband Spectrum of a Modulated RF Carrier

N is the number of sub-bands

Input Port Block Parameters TTITTTTTTTTT T T T TTTT 71T

—— | [e—— Af = 1/(tg"N)
Finite impulse response filter length: [N

Fractional bandwidth of guard bands: IF Magnitude

Maodeling delay (samples): ID
Center frequency (Hz): Iﬁ:
Sample time (s); I ts

Source impedance (ohms): 50

| | Frequency
min fa fmax

Bandwidth = 1/ts

la
<

A\

The blockset then applies the Tukey window to obtain the passband transfer
function:

Hpassband(f) = H(f) - tukeywin(N,F)

where tukeywin is the Signal Processing Toolbox™ tukeywin function.
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Calculate the Baseband-Equivalent Transfer Function

The blockset calculates the baseband transfer function, Hpysepana(f), by
translating the passband transfer function to its equivalent baseband transfer
function:

Hbaseband(f) = Hpassband (f + fc)

where f, is the specified center frequency.

The resulting baseband-equivalent spectrum is centered at zero, so the
blockset can simulate the system using a much larger time step than Simulink
can use for the same system. For information on why this translation allows
for a larger time step, see “Simulation Efficiency of a Baseband-Equivalent
Model” on page A-18.

The baseband transfer function is shown in the following figure.

Baseband-Equivalent Spectrum

Magnitude

Centered at zero

I/ Frequency

-1 /21S 0 1 /2tS

1 /tS

Calculate the Baseband-Equivalent Impulse Response

The blockset calculates the baseband-equivalent impulse response by
performing the following steps:
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1 Calculate the inverse FFT of the baseband transfer function. For faster
simulation, the block calculates the IFFT using the next power of 2 greater
than the specified finite impulse response filter length. Then, it truncates
the impulse response to a length equal to the filter length specified. When
the finite impulse response 1s truncated to the length specified by the user,
the effect of the truncation is similar to windowing with a rectangular
window.

2 Apply the delay specified by the Modeling delay (samples) parameter
in the Input Port block dialog box. Selecting an appropriate value for this
delay ensures that the baseband-equivalent model has a causal response by
moving the time window such that the model energy is concentrated at the
center of the window, as shown in the following figure:
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Without delay:
Magnitude
»
®
T ¢« o o !
N-1
Sub-Band (Tap) Number
With a 4-sample delay:
Magnitude
6 o 1 T

Sub-Band (Tap) Number

Simulation Efficiency of a Baseband-Equivalent
Model

The baseband-equivalent modeling technique improves simulation speed by
allowing the simulator to take larger time steps. To simulate a system in the
time domain, Simulink would require a step size of:

1
X
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Using the baseband-equivalent model of the same system, whose spectrum
has been shifted down by £, allows for a much larger time step of:

1 1
t = =
step 2(fmax - fc) fmax - fmin

Example — Select Parameter Values for a
Baseband-Equivalent Model

* “Baseband-Equivalent Modeling Example Overview” on page A-19
® “Create the Model” on page A-19

® “Specify Model Parameters” on page A-22

¢ “Run the Simulation and Analyze the Results” on page A-29

¢ “Reducing Acausal Response in the Baseband-Equivalent Model” on page
A-30

¢ “Introduce Delay into the Baseband-Equivalent Model” on page A-31

Baseband-Equivalent Modeling Example Overview

In this example, you model an RF transmission line stimulated by a pulse
and plot the baseband-equivalent model that the blockset uses to simulate
the transmission line in the time domain. You compare the effects of
using different parameter values for the baseband-equivalent model. This
example helps you understand how to use these parameters to best apply
the baseband-equivalent modeling paradigm of performing time-domain
simulation using a limited band of frequency data.

Create the Model

In this part of the example, you perform the following tasks:

® “Select Blocks to Represent System Components” on page A-20
¢ “Build the Model” on page A-20
® “Specify Model Variables” on page A-22
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A-20

Select Blocks to Represent System Components. In this part of the
example, you select the blocks to represent:

¢ The input signal

¢ The RF transmission line

® The baseband-equivalent model display

The following table lists the blocks that represent the system components and
a description of the role of each block.

Block

Description

Discrete Impulse

Generates a frame-based pulse input signal.

Real-Imag to
Complex

Converts the real pulse signal into a complex pulse
signal.

Input Port

Establishes parameters that are common to all
blocks in the RF transmission line subsystem,
including the source impedance of the subsystem
that is used to convert Simulink signals to the
physical modeling environment.

RLCG
Transmission Line

Models the signal attenuation caused by an RF
transmission line.

Output Port

Establishes parameters that are common to all
blocks in the RF transmission line subsystem.
These parameters include the load impedance of the
subsystem, which is used to convert RF signals to
Simulink signals.

Complex to
Magnitude-Angle

Converts the complex signal from the Output Port
block into magnitude-angle format.

Vector Scope

Displays the time-domain baseband-equivalent
model.

Build the Model. In this part of the example, you create a Simulink model,
add blocks to the model, and connect the blocks.

1 Create a model.
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2 Add to the model the blocks shown in the following table. The Library Path

column of the table specifies the hierarchical path to each block.

Block Library Path Quantity

Discrete Impulse DSP System Toolbox > Sources 1

Real-Imag to Complex | Simulink > Math Operations 1

Input Port SimRF > Equivalent Baseband > Input/Output | 1
Ports

RLCG Transmission SimRF > Equivalent 1

Line Baseband > Transmission Lines

Output Port SimRF > Equivalent Baseband > Input/Output | 1
Ports

Complex to Simulink > Math Operations 1

Magnitude-Angle

Vector Scope DSP System Toolbox > Sinks 1

3 Connect the blocks as shown in the following figure.
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Now you are ready to specify model variables.

Specify Model Variables. Type the following at the MATLAB prompt to set
up workspace variables for the model:

t s = 5e-10; % Sample time

f c = 3e9; % Center frequency

taps = 64; % Filter length

Now you are ready to specify the block parameters.

Specify Model Parameters
In this part of the example, you specify the following parameters to represent
the behavior of the system components:

e “Input Signal Parameters” on page A-23
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* “Transmission Line Subsystem Parameters” on page A-24

e “Signal Display Parameters” on page A-28

Input Signal Parameters. You generate the frame-based complex pulse
source signal using two blocks:

® The Discrete Impulse block generates a real pulse signal.

® The Real-Imag to Complex block converts the real signal to a complex
signal.

Note All signals in the RF model must be complex to match the signals in
the physical subsystem, so you create a complex input signal.

1 In the Discrete Impulse block parameters dialog box:
* Set Sample time to t_s.

e Set Samples per frame to 2*taps.

Source Block Parameters: Discrete Impulse
Discrete Impulse (mask) (link)

£2 |

Output a discrete unit impulse. The impulse will be offset by the number
of samples in the Delay parameter.

Main Data Types

Delay (samples):

]

Sample time:

ts

Samples per frame:

2%taps

\} oK H Cancel ” Help H Apply
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2 Set the Real-Imag to Complex block Input parameter to Real. Changing
this parameter changes the number of block inputs from two to one, making
the block fully connected.

Function Block Parameters: Real-Imag to Complex (==
Real-Imag To Complex

Construct a complex output from real and/or imaginary input.

Parameters

Input: | Real -

Imag part:
0

Sample time (-1 for inherited):
-1

[ 0K H Cancel H Help I Apply

Transmission Line Subsystem Parameters. In this part of the example,
you configure the blocks that model the RF filter subsystem—the Input Port,
Transmission Line, and Output Port blocks.

1 In the Input Port block parameters dialog box:

¢ Set Treat input Simulink signal as to Incident power wave.

This option tells the blockset to interpret the input signal as the incident
power wave to the RF subsystem, and not the source voltage of the RF
subsystem.
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Note If you use the default value for this parameter, the software
interprets the input Simulink signal as the source voltage. As a result,
the source and the load that model the Input Port and Output Port
blocks, respectively, introduce 6 dB of loss into the physical system at all
frequencies. For more information on why this loss occurs, see the note
in “Convert to and from Simulink Signals” on page A-33.

Set Finite impulse response filter length to taps.

Set Center frequency to f_c.

Set Sample time (s) to t_s.

This sample time is equivalent to a modeling bandwidth of 1/t_s seconds.

Set Input Processing to Columns as channels (frame based).
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A-26

-

Block Parameters: Input Port |_£_|
Input Port

Connection block from Simulink to RF Blockset physical blocks.

The RF Blockset physical blocks use a baseband-equivalent modeling technique.
This technique models a bandwidth of 1/(Sample time), centered at the specified
Center frequency parameter value. This frequency value corresponds to 0 Hz in the
baseband-equivalent model.

The block provides the option to interpret the Simulink signal as either the incident
power wave to the RF system or the source voltage of the RF system. The 'Incident
power wave' option is the most common RF modeling interpretation, while the
'Source voltage' option is provided for backwards compatibility. If the input Simulink
signal is the incident power wave, the output of the RF system is the transmitted
power wave. If the input is the source voltage, the output is the load voltage.

The block controls the modeling of RF Blockset physical blocks between this block
and the Output Port block using:

- FIR filters to model the frequency-dependent characteristics

- Look-up tables to model the nonlinear behaviors

Optional guard bands can be specified as a fraction of the modeling bandwidth. The
guards bands are implemented by applying a Tukey window to the frequency
response. Modeling delay may be added to improve the response of the FIR filters.

Parameters
Treat input Simulink signal as: Incident power wave =
Source impedance (ohms): 50

Finite impulse response filter length: taps

Fractional bandwidth of guard bands: 0

Modeling delay (samples): 0
Center frequency (Hz): fc
Sample time (s): ts
Input processing: Columns as channels (frame based) T |
[¥] Add noise
Initial seed: 67987
OK ] | Cancel | | Help | | Apply
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2 In the RLCG Transmission Line block parameters dialog box:
¢ Set Inductance per length (H/m) to 50.
* Set Capacitance per length (F/m) to .02.
* Set Frequency (Hz) to f_c.

® Set Transmission line length (m) to 0.5*t_s.

Block Pararneters: RLCG Transmission Line
RLCG Transmission Line

Model an RLCG transmission line.

Main Visualization

Resistance per length (chms/m): 0
Inductance per length (H/m): 0
Capacitance per length (F/m): 0

Conductance per length (S/m}: 0

Frequency (Hz): 1e9
Interpolation method: [Linear
Transmission line length (m): 0.01
Stub mode: [Not a stub
Termination of stub: Open
[ 0K ] l Cancel ] l Help ]

3 Accept the default parameters for the Output Port block to use a load

impedance of 50 ohms.
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Block Parameters: Qutput Port @
Output Port
Connection block from RF Blockset physical blocks to Simulink.

After running a simulation, various parameters of the RF system that
is delimited by an Input Port block and this Output Port block can be
visualized.

Main Visualization

Load impedance (ohms): 50

[ DK H Cancel H Help I Apply

Signal Display Parameters. In this part of the example, you specify the
parameters that set up the baseband-equivalent model display. You use the
Complex to Magnitude-Angle block to convert the RF subsystem output to
magnitude format, and you use the Vector Scope block to display the output
signal.

For the Vector Scope block, you specify that the signal is an amplitude as a
function of time, and you set the range of the x- and y-axes to make sure that
the entire signal is visible.

1 Set the Complex to Magnitude-Angle block Output parameter to

Magnitude. Changing this parameter changes the number of block outputs
from two to one, making the block fully connected.
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Function Block Parameters: Complex to Magnitude-Angle @
Complex to Magnitude-Angle

Compute magnitude and/or radian phase angle of the input.

Parameters

Output: |Magnitude -

Sample time (-1 for inherited):
-1

[ 0K ]| Cancel || Help | Apply

2 In the Vector Scope block parameters dialog:
® In the Scope Properties tab, set Input domain to User-defined.
¢ In the Axis Properties tab:
- Set X-axis title to Index.
= Set Minimum Y-limit to 0.
= Set Maximum Y-limit to 1.
= Set Y-axis title to Amplitude.

¢ In the Line Properties tab, set Line markers to stem.
Run the Simulation and Analyze the Results
Before you run the simulation, set the stop time by selecting
Simulation > Configuration Parameters in the model window and
entering 2*t_s* (taps-1) for the Stop time parameter.
To run the simulation, select Simulation > Start in the model window.
You can view the baseband-equivalent model in the Vector Scope window

while the model is running. This window appears automatically when you
start the simulation. The following plot shows the baseband-equivalent
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model, which contains a significant amount of acausal energy because of
the limited bandwidth of the model.

Acausal response

Amplitude

PSR

L ()
0 ommfmm‘wmmmzmmﬁju’ ; : :

Frame: 2 Index x 16°

Baseband-Equivalent Model

The next part of the example shows you how to reduce this acausal response.

Reducing Acausal Response in the Baseband-Equivalent Model
In this part of the example, you adjust the Fractional bandwidth of guard
bands parameter. This parameter controls the shaping of the filter that the
blockset applies to create the baseband-equivalent model.

1 Set the Input Port Fractional bandwidth of guard bands parameter to
0.2.

2 Rerun the simulation.

The following figure shows the Vector Scope plot. You can see that the acausal
response 1s lower than it was for the previous simulation, but there is still
some energy wrapping around the end of the model because it is periodic.
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Reduced acausal response

Amplitude

Pt
01 ' T

(1] 1 2 = 4 5 6
Frame: 2 Index x 107

Baseband-Equivalent Model with Filter Shaping

Note You can further reduce the acausal response in the baseband-equivalent
model by increasing the value of the Fractional bandwidth of guard
bands parameter above 0.2, but if you use a high value, you compromise the
fidelity of the gain of the transmission line.

The next section shows you how to shift the response to avoid this wrapping.

Introduce Delay into the Baseband-Equivalent Model

In this part of the example, you adjust the Modeling delay (samples)
parameter. This parameter controls the delay the blockset applies to create
the baseband-equivalent model.

1 Set the Input Port Modeling delay (samples) parameter to 12.

2 Rerun the simulation.

The following figure shows the Vector Scope plot. The response of the
baseband-equivalent model is concentrated in a small time window. This

model provides the most accurate time-domain simulation of the specified
band of frequency data.
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Baseband-Equivalent Model with Filter Shaping and Delay
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ignals

Convert to and from Simulink Signals

Signal Conversion Specifications

When you simulate an RF model, the blockset must convert the mathematical
Simulink signals to and from the physical modeling environment. The
following figure shows the signals involved in the conversion.

Input & | General Amplifier (S-S S_PErETFtEE Fenaral Amplifier (s OQutput =
Port Armplifier Port
Input Port Zeneral Amgplifier S5-Fara I'!'I-!E‘IZEIE- Zeneral Amplifier Output Port
Amplifier /
Sjmullink ¥y L | + Simullink
signa signa
RF System L ]
Sin — Sout
Input Port Block Output Port Block
Where:

® Zyis the Source impedance (ohms) parameter of the Input Port block.

® Z,is the Load impedance (ohms) parameter of the Output Port block.

There are two options for interpreting the Simulink signal that enters the
Input Port block:
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e S, is the incident power wave. For more information about this option, see
“Interpret Simulink Signals as Incident Power Waves” on page A-34.

e S, is the source voltage. For more information about this option, see
“Interpret Simulink Signals as Source Voltages” on page A-36.

Interpret Simulink Signals as Incident Power Waves
The blockset provides the option to interpret the input Simulink signal, S, , as
the incident power wave, a,;, at the first port of the RF system. The following
figure shows the model for this interpretation.

Input & | General Amplifier |8 E—F'ETEI'!'H-E‘IZEPE- & | General Amplifier e Output 2
Port Amplifier Port
Input Port General Amplifier S5-Para I'!'I-!E‘IZEIE- General Amplifier Output Port
Amplifier
upl (lp2:0
— —
_— Vs Is -
Sllmulllnk | + Slmullmk
signa signa
: RF System A v
Sin — Sout
<— —>
bp1 bp2

In the figure, b, 1s the transmitted power wave at the second port of the RF
system. This is the signal at the output of the Output Port block, S_,.

For a 2-port RF system, the incident and transmitted power waves are
defined as:
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where:

® Zg the Source impedance (ohms) parameter of the Input Port block, is
defined as:

Zy=Ry+ jXq

® Z,, the Load impedance (ohms) parameter of the Output Port block, is
defined as:

Z; =R, +iX]

Solving the power wave equations for S, and S, gives the following
relationships:

Sjy = 8

" 2R
VEL

Sout =~—VL

ou ZL

The implications of this interpretation are:

* IS, |2 is equal to the power available from the source, P, .
* |Sou |2 is equal to the power delivered to the load, P, ..

For a linear RF system, P,,; = G;P,,; where G, is the transducer power gain.
As a result, the Simulink signals at the input and output of the RF system
have the following relationship:

|Sout |2 = Gt |Sin |2
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Note You can plot G, from the Output Port block’s Visualization tab.

Interpret Simulink Signals as Source Voltages
The blockset provides the option to interpret the input Simulink signal, S.

n’

as the source voltage, Vg, of the RF system. The following figure shows the
model for this interpretation.

Input & | General Amplifier E—F'ETEI'!'H-E‘IZEPE- Zeneral Amplifier [ Output 2
Port Amplifier Port
Input Port General Amplifier S5-Para I'!'I-!E‘IZEIE- General Amplifier Output Port
Amplifier /
Sjmullink %y I | + Simullink
signa signa
[ RF System N
Sin — Sout
Input Port Block Output Port Block
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With this interpretation, the signal at the output of the Output Port block is

the load voltage, V;.

The blockset interpretation of the input Simulink signal as the source
voltage, V,, produces different results than the interpretation where the
input Simulink signal is the incident power wave. When the source and load
impedances are the same and real, the former interpretation produces 6 dB of
loss compared to the latter.



Convert to and from Simulink® Signals

Specify Input Signal Conversions

To specify the way in which the blockset interprets the input Simulink signal,
you change the value of the Treat input Simulink signal as parameter in
the Input Port dialog box. The available parameter values are:

® Incident power wave — Interpret the input signal as the incident power
wave.

® Source voltage — Interpret the input signal as the source voltage.
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5] Block Parameters: Input Port

—Input Paort
Connection block from Simulink to RF Blockset physical blocks,

The RF Blockset physical blacks use a baseband-equivalent modeling technique.
This technigue models a bandwidth of 1f{Sample tme), centered at the specified
Center frequency parameter value. This frequency value corresponds to 0 Hz in
the baseband-equivalent model.

The block provides the option to interpret the Simulink signal as either the incident
power wave to the RF system or the source voltage of the RF system. The
'Incident power wave' option is the most common RF modeling interpretation,

while the "Source voltage' option is provided for backwards compatibility, If the
input Simulink signal is the incident power wave, the output of the RF system is the
transmitted power wave. If the input is the source voltage, the output

is the load voltage.

The block controls the modeling of RF Elockset physical blocks between this block
and the Qutput Port block using:

- FIR filters to model the frequency-dependent characteristics

- Look-up tables to model the nonlinear behaviors

Optional guard bands can be specified as a fraction of the modeling bandwidth.
The guards bands are implemented by applying a Tukey window to the frequency
response. Modeling delay may be added to improve the response of the FIR filters.

—Parameters
Treat input Simulink signal as: ISDurce voltage LI
Source impedance {(ohms): I 50

Finite impulse response filter length: I 128

Fractional bandwidth of guard bands: ID

Modeling delay (samples): IU
Center frequency (Hz): I 2e8
Sample time (s): I 1e-7
V¥ Add noise
Initial seed: |67987

“Help. Apply

OK I Cancel |

Change this parameter value
to change the way the blockset
interprets the input signal.
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e “2.Port Mixer Blocks” on page B-2
e “Model a Mixer Chain” on page B-4

® “Quadrature Mixers” on page B-6
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2-Port Mixer Blocks

Typically, the block diagram of a mixer has three ports, as shown in the
following representation of a downconversion mixer.

RF IF

L0

The mathematical and physical mixer blocks model both a mixer and a local
oscillator, so they have only two ports.

RF IF

hlger

The following figure shows the icons of the mixer blocks. The icons of all the
mixer blocks show the internal local oscillator.
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=] untitled * O] x|

File Edit Wiew Simulation Format Tools  Help

DS EHES| + BB 42 8o

Mathematical Physical
Mixer - & &) Mixer
Block Blocks

Genaral Mixer

hlizer
L i i i L i
éé s éé b éé z
S-Parameters r-Parameters Z-Parameters
hlizer hizer hlizer
Ready |100% | | |ode4s i

For the physical blocks, you can use the LO frequency (Hz) parameter to
specify the local oscillator’s frequency.

For more information, see the individual block reference pages.
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Model a Mixer Chain

B-4

SimRF Equivalent Baseband software uses a baseband equivalent model to
simulate RF components in the time domain, as described in Appendix A,
“SimRF Equivalent Baseband Algorithms”. The blockset only models a band
of frequencies around the carrier frequency of each component; the frequency
band is determined by the following parameters of the corresponding Input
Port block:

® Reciprocal of the Sample time (s)
¢ Center frequency (Hz)
When a mixer is present in a physical subsystem, it shifts the carrier

frequency of the signal. This shift affects the frequencies that are used to
create baseband equivalent model.

To illustrate how the mixer works, consider a typical RF mixer chain that
consists of the following components:

¢ Direct Quadrature Upconverter

¢ High-Power Amplifier

¢ Channel

® Low-Noise Amplifier

® Downconverting Mixer

e [F Filter

¢ Direct Quadrature Downconverter

The following diagram shows these components and the band of frequencies
that are simulated for each component. The signals at the input and output of
the cascade are baseband complex. For the cascade, the diagram shows the
real passband frequencies that are used to create the baseband-equivalent

model, which is centered at zero. For a detailed explanation of how to use the
blockset to model quadrature mixers, see “Quadrature Mixers” on page B-6.
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tS = Input Port Sample Time
Frequency
A
fop + 1/(2tg)
fRF
fop- 112ty
fie* 2y
fe- 1/2tg)
+ 12ty
0 | | | L | |
[ [ [ [ [ [ [
- 1/(2*ts) High'POWer Channel LOW'N.Oise Mixer IF Filter
Direct Quadrature  Amplifier Amplifier Direct Quadrature
Upconverter Downconverter
— I PCTTTTTT TN
| 1 ! 1
: Inpt . @i@ General s Ot pt Rt Inpt . General . s @i@ e Ctput :
| | Port 1 | Amplifier Part LB Part Amplifier 1 Part }|
! Mixer | TR Miser2 _ | Mier |
: Input 1 HPA Dutput Channel Input LHA IF Filter Cutput 1
| Bt ! Part Port 1 : Part 1 :
1 1
t-1----1--"' SetLO Frequency - ---- !
parameter to 0 Hz Set Frequency
Set Center Frequency Set Center Frequenc parameter of first Set Frequency
parameter to f, - amator to f quency receiver LO to parameter of second
P RF fop-fiF reciever LO to 0 Hz
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Quadrature Mixers

B-6

In this section...

“Use SimRF Equivalent Baseband Software to Model Quadrature Mixers”
on page B-6

“Model Upconversion I/Q Mixers” on page B-6

“Model Downconversion I/Q Mixers” on page B-7

“Simulate I/Q Mixers” on page B-8

Use SimRF Equivalent Baseband Software to Model
Quadrature Mixers

RF Blockset™ software lets you model upconversion and downconversion
quadrature mixers using Physical blocks. These mixers convert a complex
baseband signal up to and down from the desired carrier frequency by mixing
the real and imaginary parts of the signal with a cosine and sine of the same
frequency.

Model Upconversion 1/Q Mixers

You use the Input Port block to model the upconversion of in-phase/quadrature
baseband signals to modulated signals at a finite real carrier frequency.

The real component of the block input represents the in-phase signal. The
imaginary component of the block input represents the quadrature signal.

To model a perfect quadrature upconversion mixer, use the Input Port block
with the Center frequency (Hz) parameter set to the carrier frequency.

To model an imperfect quadrature upconversion mixer, use the Input
Port block with the Center frequency (Hz) parameter set to the carrier
frequency. Follow this block immediately by a mixer block with the LO
frequency (Hz) parameter set to 0. Specify imperfections as follows:

e S-parameters — Use S-parameters to specify imperfections such as
frequency response. For a mixer, S,; describes the conversion gain, as
explained in the Network Parameters section of the reference page for
each mixer block. Use purely real and purely imaginary S,, parameters to
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represent multiplying the input signal by a pure cosine and a pure sine,
respectively. Use a complex S,, parameter to represent multiplying the
input signal by a combination of sine and cosine.

® Thermal noise — Use thermal noise to specify temperature-dependent
random noise.

® Phase noise — Use the phase noise to specify noise to add to the angle
component of the input signal.

¢ Nonlinearity — Use nonlinearity (specified as output power and phase as
a function of input power and frequency in an AMP file or as third-order
intercept point) to specify nonlinear mixer behavior as a function of input
power.

Note If you specify a nonzero value for the local oscillator frequency of the
mixer and set the Type parameter to Upconverter, the blockset converts the
signal to a frequency above the center frequency. The final IF value is the sum
of the Input Port center frequency and the mixer local oscillator frequency.

Model Downconversion I/Q Mixers

You use the Output Port block to model the downconversion of
in-phase/quadrature modulated carrier signals to baseband signals. The real
component of the block output represents the in-phase signal. The imaginary
component of the block output represents the quadrature signal.

The finite real carrier frequency is set automatically as the sum of the center
frequency of the Input Port block and the LO frequencies in any mixer blocks
in the cascade.

Note In the cascade, upconversion mixers increase the carrier frequency and
downconversion mixers decrease the carrier frequency.

The Output Port block models a perfect quadrature downconversion mixer.
To model an imperfect quadrature downconversion mixer, precede the Output
Port block immediately by a mixer block with the LO frequency (Hz)
parameter set to 0. Specify imperfections as follows:
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e S.-parameters — Use S-parameters to specify imperfections such as
frequency response. For a mixer, S,; describes the conversion gain, as
explained in the Network Parameters section of the reference page for
each mixer block. Use purely real and purely imaginary S,, parameters to
represent multiplying the input signal by a pure cosine and a pure sine,
respectively. Use a complex S,, parameter to represent multiplying the
input signal by a combination of sine and cosine.

® Thermal noise — Use thermal noise to specify temperature-dependent
random noise.

® Phase noise — Use the phase noise to specify noise to add to the angle
component of the input signal.

® Nonlinearity — Use nonlinearity (specified as output power and phase as
a function of input power and frequency in an AMP file or as third-order
intercept point) to specify nonlinear mixer behavior as a function of input
power.

Note The mixer output frequency must be positive. This means that if
you choose a downconverting mixer, the input carrier frequency f,, must be
greater than the local oscillator frequency f;,. Otherwise, an error appears.

Simulate 1/Q Mixers

When you model an I/Q mixer in the blockset, the center frequency you
specify in the Input Port block dialog is only used to build a complex-baseband
equivalent model of the cascade that represents the mixer. The blockset
simulates this model using a fixed time step equal to the sample time that
you specify in the Input Port block dialog box.

To examine the model in the Simulink window:

1 Select Simulation > Update Diagram to update the model diagram.

2 Right-click the Output Port block and select Look Under Mask.

For more information on baseband-equivalent modeling, see Appendix A,
“SimRF Equivalent Baseband Algorithms”.
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